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Пояснительная записка 

Данные методические указания по выполнению практических работ являются 

частью учебно-методического комплекса по дисциплине «Информационное обеспечение 

логистических процессов» и предназначены для обучающихся п о  специальности 

38.02.03 Операционная деятельность в логистике. 

Целью практических работ студентов является приобретение навыков работы на 

персональном компьютере в среде ОС Windows и основных офисных программах MS 

Office. Выполнение практических работ направлено на закрепление полученных в ходе 

изучения тем знаний и реализацию выполнения требований. Практические занятия 

повышают качество знаний, их глубину, конкретность, оперативность, значительно 

усиливают интерес к изучению дисциплины, помогают студентам полнее осознать 

практическую значимость естественных наук. 

Во всех практических работах учитывается полнота и качество выполнения 

практических заданий. 

Требования к содержанию и объему выполняемых заданий выполняется на ПК и 

оформляется в тетради, в соответствии с требованиями к практической работе. 

Методические рекомендации по проведению практических занятий дисциплине 
«Информационное обеспечение логистических процессов» ориентированы на достижение 
следующих целей: 

 оценивать достоверность информации, сопоставляя различные источники; 

 распознавать информационные процессы в различных системах; 

  использовать готовые информационные модели, 

 оценивать их соответствии 
реальному объекту и целям моделирования; 

 осуществлять выбор способа представления информации в

 соответствии с поставленной задачей; 

  иллюстрировать учебные работы с использованием средств 

информационных технологий; 

  создавать информационные объекты сложной структуры, 

 в том числе гипертекстовые; 

 просматривать, создавать, редактировать, сохранять записи в базах данных; 

 осуществлять поиск информации в базах данных, компьютерных сетях и пр.; 

  представлять числовую информацию различными способами (таблица, 

массив, график, диаграмма и пр.); соблюдать правила техники безопасности и 
гигиенические рекомендации при использовании средств ИКТ. 

Практические работы, выполняемые студентами, позволяют им приобрести опыт 

познавательной и практической деятельности, а также способствуют освоению общих 

компетенций по Федеральному Государственному образовательному стандарту СПО: 

  

 ОК 1. Понимать сущность и социальную значимость своей будущей профессии, проявлять 

к ней устойчивый интерес. 

 ОК 2. Организовывать собственную деятельность, выбирать типовые методы и способы 
выполнения профессиональных задач, оценивать их эффективность и качество. 

 ОК 3. Принимать решения в стандартных и нестандартных ситуациях и нести за них 

ответственность. 

 ОК 4. Осуществлять поиск и использование информации, необходимой для эффективного 

выполнения профессиональных задач, профессионального и личностного развития. 

 ОК 5. Использовать информационно-коммуникационные технологии в профессиональной 
деятельности. 

 ОК 6. Работать в коллективе и команде, эффективно общаться с коллегами, руководством, 

потребителями. 

 ОК 7. Брать на себя ответственность за работу членов команды (подчиненных), результат 



выполнения заданий. 

 ОК 8. Самостоятельно определять задачи профессионального и личностного развития, 

заниматься самообразованием, осознанно планировать повышение квалификации. 

 ОК 9. Ориентироваться в условиях частой смены технологий в профессиональной 

деятельности. 

 

 

Практическая работа № 1-2 

Тема: Анализ использования информационных систем и технологий в 

логистической компании ООО "ПЭК". 

Цель работы: Выявить основные информационные системы и технологии, используемые 

в ООО "ПЭК", оценить их эффективность и разработать рекомендации по их 

совершенствованию или внедрению новых решений для повышения 

конкурентоспособности компании. 

Задачи работы: 

1. Изучить теоретические аспекты применения информационных систем и 

технологий в логистической деятельности. Этот пункт остается без изменений из 

предыдущего варианта. Он необходим для формирования теоретической базы 

исследования. 

2. Провести анализ использования информационных систем и технологий в ООО 

"ПЭК". 
o Описать ООО "ПЭК" как логистическую компанию (основные виды деятельности, 

география присутствия, клиентская база, конкурентные преимущества - 

информация из открытых источников: сайт компании, публикации в СМИ, и т.д.). 

o Описать основные бизнес-процессы ООО "ПЭК" (прием и обработка заказов, 

управление складом, планирование маршрутов, доставка грузов, управление 

автопарком, взаиморасчеты с клиентами и поставщиками). Постарайтесь 

выявить как можно больше процессов, используя информацию с сайта компании и 

из других источников. 

o Определить, какие информационные системы и технологии использует ООО 

"ПЭК" для поддержки каждого из этих бизнес-процессов. Максимально 

используйте информацию с сайта компании (особенно разделы "Для бизнеса", 

"ИТ-решения", "Интеграция") и публикации в СМИ, где упоминаются ИТ-системы 

компании. Не исключено, что компания использует готовые решения и 

собственные разработки. 

o Оценить эффективность использования ИС и ИТ на основе доступных данных 

(например, скорость обработки заказов, снижение издержек, повышение точности 

доставки, повышение удовлетворенности клиентов - здесь нужно искать любые 

количественные показатели в отчетах компании, публикациях в СМИ или 

оценивать на основе анализа функциональности систем). 

o Выявить проблемы и узкие места в использовании информационных систем и 

технологий (например, отсутствие интеграции между различными системами, 

устаревшие технологии, недостаточная автоматизация процессов, низкая 

квалификация персонала). Это самый сложный пункт, так как прямую 

информацию компания вряд ли предоставит. Здесь нужно делать обоснованные 



предположения на основе анализа бизнес-процессов и информации об 

используемых системах. 

3. Разработать предложения по совершенствованию использования 

информационных систем и технологий в ООО "ПЭК". 
o Предложить конкретные решения по устранению выявленных проблем и узких 

мест (например, внедрение новых информационных систем, модернизация 

существующих систем, интеграция различных систем, обучение персонала). 

o Оценить экономическую целесообразность предложенных решений. В рамках 

данной работы достаточно оценить целесообразность на качественном уровне, 

без сложных расчетов, основываясь на анализе потенциальных выгод и затрат. 

o Рассмотреть риски, связанные с внедрением предложенных решений, и 

предложить меры по их минимизации. 

o (Опционально) Предложить варианты использования инновационных технологий 

(например, IoT, Big Data, AI) для повышения эффективности логистической 

деятельности ООО "ПЭК". Например, прогнозирование спроса на перевозки с 

использованием Big Data, оптимизация маршрутов с использованием AI, 

мониторинг состояния грузов с использованием IoT. 

Объект исследования: ООО "ПЭК" 

Предмет исследования: Информационные системы и технологии, применяемые в ООО 

"ПЭК" 

Методы исследования: 

 Анализ литературы по тематике логистических информационных систем. 

 Анализ данных из открытых источников (веб-сайт ООО "ПЭК", публикации в СМИ, 

отраслевые отчеты и исследования о компании, отзывы клиентов). 

 (Опционально) Интервью с сотрудниками ООО "ПЭК" или клиентами компании (если 

есть возможность, что маловероятно, но стоит попробовать). 

 SWOT-анализ (для оценки сильных и слабых сторон, возможностей и угроз, связанных 

с использованием ИС и ИТ в ООО "ПЭК"). 

Структура работы: (Рекомендуемая) 

1. Введение 

2. Глава 1. Теоретические основы применения информационных систем и 

технологий в логистике. 

3. Глава 2. Анализ использования информационных систем и технологий в ООО 

"ПЭК". 
o 2.1. Общая характеристика компании ООО "ПЭК". 

o 2.2. Описание бизнес-процессов ООО "ПЭК". 

o 2.3. Используемые информационные системы и технологии в ООО "ПЭК". 

o 2.4. Оценка эффективности использования ИС и ИТ в ООО "ПЭК". 

o 2.5. Выявление проблем и узких мест в использовании ИС и ИТ в ООО "ПЭК". 

4. Глава 3. Предложения по совершенствованию использования информационных 

систем и технологий в ООО "ПЭК". 

5. Заключение 

6. Список литературы 
7. Приложения (если есть). 

Где искать информацию (начните отсюда): 



 Официальный сайт ООО "ПЭК": Изучите все разделы сайта, особенно разделы "О 

компании", "Услуги", "Для бизнеса", "ИТ-решения", "Интеграция". Обратите 

внимание на упоминания каких-либо IT-партнеров. 

 Публикации в СМИ: Поищите статьи про ООО "ПЭК" в деловых изданиях, на 

сайтах, посвященных логистике и транспорту ("Логирус", "РЖД-Партнер" и др.). 

Ищите упоминания об автоматизации, внедрении новых технологий, IT-проектах. 

 Отраслевые отчеты и исследования: Поищите отраслевые отчеты о рынке 

логистики в России, где может быть информация о технологических трендах и о 

компаниях, которые их внедряют. 

 Отзывы клиентов: Изучите отзывы клиентов о работе ООО "ПЭК" на различных 

площадках (сайты-отзовики, социальные сети). Недовольство клиентов может 

указывать на проблемы в бизнес-процессах и недостатки используемых 

информационных систем. 

Ключевые слова для поиска: 

 ПЭК информационные технологии 

 ПЭК автоматизация логистики 

 ПЭК IT-решения 

 WMS ПЭК 

 TMS ПЭК 

 интеграция с ПЭК 

 

Практическая работа № 5-6 Работа с файловыми менеджерами, архиваторами, 

утилитами 

Задание 1: Работа с файловым менеджером (на примере Windows Explorer или Total 

Commander) 

 Создать структуру папок: 

o Создайте на диске C: папку с именем MyFiles. 

o Внутри MyFiles создайте три подпапки: Documents, Pictures, Archives. 

o Внутри Documents создайте подпапки Reports, Letters. 

 Копирование и перемещение файлов: 

o Скопируйте несколько текстовых файлов (*.txt, создайте их, если нет) из папки 

C:\Windows\System32 в папку C:\MyFiles\Documents. 

o Переместите все файлы из C:\MyFiles\Documents в C:\MyFiles\Documents\Reports. 

 Переименование файлов и папок: 

o Переименуйте папку C:\MyFiles\Documents\Reports в 

C:\MyFiles\Documents\SalesReports. 

o Переименуйте один из текстовых файлов в C:\MyFiles\Documents\SalesReports так, 

чтобы его имя начиналось с Report_. 

 Поиск файлов: 

o Найдите все файлы с расширением .txt в папке C:\MyFiles и ее подпапках. 

o Найдите все файлы, содержащие в имени слово Report, в папке 

C:\MyFiles\Documents\SalesReports. 

 Работа с атрибутами файлов: 

o Сделайте один из файлов в C:\MyFiles\Documents\SalesReports скрытым. 

o Уберите атрибут "Только для чтения" у одного из файлов в 

C:\MyFiles\Documents\SalesReports. 



 (Для Total Commander) Настройка панелей, изменение вида отображения файлов, 

использование фильтров. 

Задание 2: Работа с архиватором (на примере 7-Zip или WinRAR) 

 Создание архива: 

o Заархивируйте папку C:\MyFiles в архив C:\MyFiles.zip (или .rar). 

o Создайте многотомный архив (разделите архив на несколько файлов) размером 

каждого тома 1MB. 

o Создайте самораспаковывающийся архив (SFX) из папки C:\MyFiles. 

 Извлечение файлов из архива: 

o Извлеките все файлы из архива C:\MyFiles.zip в папку C:\ExtractedFiles. 

o Извлеките только файлы с расширением .txt из архива C:\MyFiles.zip в папку 

C:\ExtractedTextFiles. 

 Добавление и удаление файлов из архива: 

o Добавьте новый текстовый файл в архив C:\MyFiles.zip. 

o Удалите один из текстовых файлов из архива C:\MyFiles.zip. 

 Установка пароля на архив: 

o Защитите архив C:\MyFiles.zip паролем. 

 Проверка целостности архива: 

o Проверьте архив C:\MyFiles.zip на наличие ошибок. (Для WinRAR - "Тестировать 

архив"). 

Задание 3: Работа с утилитами (на примере командной строки Windows или Linux) 

 Основные команды (Windows): 

o Перейдите в командной строке в папку C:\MyFiles. (cd C:\MyFiles) 

o Создайте папку Temp внутри C:\MyFiles. (md Temp) 

o Скопируйте файл C:\MyFiles\Documents\SalesReports\Report_1.txt в папку 

C:\MyFiles\Temp. (copy C:\MyFiles\Documents\SalesReports\Report_1.txt 

C:\MyFiles\Temp) 

o Удалите папку C:\MyFiles\Temp (предварительно удалив все файлы в ней). (rd 

C:\MyFiles\Temp, предварительно del C:\MyFiles\Temp\*.*) 

o Выведите список файлов и папок в папке C:\MyFiles. (dir) 

 Работа с текстовыми файлами (Windows: type, find; Linux: cat, grep): 

o Создайте текстовый файл info.txt с несколькими строками текста. 

o Выведите содержимое файла info.txt на экран. (type info.txt) 

o Найдите в файле info.txt все строки, содержащие слово "example". (find "example" 

info.txt) 

 Перенаправление ввода-вывода (Windows/Linux): 

o Выведите список файлов и папок в папке C:\MyFiles в текстовый файл files.txt. (dir 

> files.txt) 

 (Дополнительно, Windows) Использование команд ping, ipconfig, tasklist. 

 

Практическая работа № 7-8. Форматирование текста. Списки. Стили  

Часть 1: Форматирование текста 

1. Подготовьте текст: Скопируйте следующий текст в документ MS Word: 

История информационных технологий – это захватывающее путешествие от простых 

абаков до сложных искусственных интеллектов. Первые компьютеры, занимавшие целые 



комнаты, сегодня умещаются в наших карманах. Развитие интернета изменило мир, 

сделав информацию доступной каждому. Сейчас мы стоим на пороге новой эры, где 

технологии искусственного интеллекта становятся неотъемлемой частью нашей жизни. 

Важно понимать, как далеко мы продвинулись и какие перспективы нас ждут в будущем. 

Знания об информационных технологиях необходимы каждому современному человеку 

для успешной адаптации в быстро меняющемся мире. 

 

Информационные технологии (ИТ) – это комплекс методов, производственных процессов 

и программно-технических средств, интегрированных с целью сбора, обработки, 

хранения, распространения, отображения и использования информации в интересах ее 

пользователей. 

2. Форматирование абзацев: 
o Выровняйте первый абзац по ширине. 

o Установите отступ первой строки первого абзаца 1,25 см. 

o Установите междустрочный интервал 1,5 для второго абзаца. 

o Выделите текст "информационных технологий" во втором абзаце курсивом. 

o Выделите текст "Знания об информационных технологиях" в первом абзаце 

полужирным начертанием. 

o Измените цвет текста во втором абзаце на темно-синий. 

o Добавьте границу вокруг второго абзаца (тип линии - сплошная, цвет - серый). 

Часть 2: Списки 

1. Создайте маркированный список: Преобразуйте следующий текст в маркированный 

список (используйте маркер в виде галочки): 

Преимущества использования информационных технологий: 

- Повышение эффективности работы 

- Улучшение коммуникации 

- Доступ к информации 

- Автоматизация процессов 

2. Создайте нумерованный список: Преобразуйте следующий текст в нумерованный 

список (используйте римские цифры): 

Этапы развития информационных технологий: 

- Механический этап 

- Электромеханический этап 

- Электронный этап 

3. Создайте многоуровневый список: Создайте многоуровневый список на основе 

следующего текста (первый уровень - цифры, второй уровень - строчные буквы): 

Составляющие информационных технологий: 

1. Аппаратное обеспечение 

   a. Компьютеры 

   b. Периферийные устройства 

2. Программное обеспечение 

   a. Системное программное обеспечение 

   b. Прикладное программное обеспечение 

Часть 3: Стили 

1. Примените встроенные стили: 
o Сделайте заголовок "История информационных технологий" (из первого задания) 

стилем "Заголовок 1". 

o Озаглавьте список преимуществ (из второго задания) стилем "Заголовок 2". 



o Озаглавьте список этапов (из второго задания) стилем "Заголовок 2". 

o Озаглавьте список составляющих (из второго задания) стилем "Заголовок 2". 

2. Измените стиль "Заголовок 2": 
o Измените шрифт стиля "Заголовок 2" на Arial. 

o Измените размер шрифта стиля "Заголовок 2" на 14 пт. 

o Сделайте стиль "Заголовок 2" полужирным. 

o Измените цвет стиля "Заголовок 2" на зеленый. 

o Выровняйте стиль "Заголовок 2" по левому краю. 

3. Создайте новый стиль: 
o Создайте новый стиль с именем "ОпределениеИТ". 

o Установите для стиля "ОпределениеИТ" шрифт Times New Roman, размер 12 пт, 

курсив, выравнивание по ширине, отступ первой строки 1 см. 

o Примените стиль "ОпределениеИТ" ко второму абзацу (где дается определение 

ИТ). 

Критерии оценки: 

 Точность форматирования текста (шрифт, размер, начертание, выравнивание, 

интервалы, отступы). 

 Правильность создания и форматирования списков (маркеры, нумерация, отступы, 

многоуровневость). 

 Корректное применение, изменение и создание стилей (соответствие требованиям, 

согласованность форматирования). 

 Общее оформление документа (аккуратность, читабельность). 

Советы: 

 Используйте вкладки "Главная", "Вставка", "Макет" и "Вид" для поиска необходимых 

инструментов. 

 Используйте диалоговые окна "Шрифт" и "Абзац" для более точной настройки. 

 Экспериментируйте с различными параметрами стилей, чтобы понять, как они 

работают. 

 Сохраните документ после выполнения каждого задания, чтобы не потерять 

результаты. 

 

Практическая работа № 9-10. Внедрение и связывание объектов 

Различия между внедрением и связыванием (Comparison) 

 Шаг 1: Описание сценариев: 
o Опишите два разных сценария использования: 

 Сценарий 1 (Внедрение): Вам нужно включить диаграмму в отчет Word, и вы 

не хотите, чтобы изменения в исходном файле Excel влияли на диаграмму в 

отчете. Отчет должен быть самодостаточным. 

 Сценарий 2 (Связывание): Вам нужно включить содержание динамически 

обновляемого текстового файла в документ Word, и вам важно, чтобы 

изменения в текстовом файле автоматически отображались в Word. 

 Шаг 2: Реализация сценариев: 
o Для Сценария 1 (Внедрение) выполните действия, описанные в Задании 1. 

Создайте диаграмму в Excel и внедрите её в документ Word. 



o Для Сценария 2 (Связывание) выполните действия, описанные в Задании 2. 

Создайте текстовый файл и свяжите его с документом Word. 

 Шаг 3: Анализ результатов: 
o Сравните результаты, полученные в обоих сценариях: 

 Что происходит с диаграммой в Word, если изменить данные в исходном файле 

Excel (для внедренного объекта)? 

 Что происходит с текстом в Word, если изменить текст в исходном текстовом 

файле (для связанного объекта)? 

 Что происходит, если удалить исходный файл Excel (для внедренного 

объекта)? 

 Что происходит, если переместить или переименовать исходный текстовый 

файл (для связанного объекта)? 

 Шаг 4: Формулирование выводов: 
o Напишите краткий отчет, в котором четко объясните различия между внедрением 

и связыванием, опираясь на результаты, полученные в ходе выполнения 

практических заданий. 

o Укажите, в каких случаях целесообразно использовать внедрение, а в каких – 

связывание. 

Дополнительные (опциональные) задания: 

Эти задания для более глубокого изучения OLE. 

 Задание 1: Внедрение и связывание объектов различных типов: 
o Повторите Задания 1 и 2, но используйте другие типы объектов: 

 Внедрите часть документа Word в другой документ Word. 

 Свяжите изображение, созданное в Paint, с документом Word. 

 Внедрите звуковой файл (например, WAV) в документ Word. (Обратите 

внимание, не все объекты можно внедрить/связать во всех приложениях) 

 Задание 2: Редактирование связанных объектов "на месте" против 

редактирования в отдельном окне: 
o В некоторых случаях, при двойном щелчке на связанном объекте, он может 

редактироваться прямо в документе Word (как внедренный объект), а в других 

случаях открывается отдельное окно приложения (например, Excel) для 

редактирования. 

o Исследуйте, от чего зависит такое поведение. (Обычно это зависит от типа объекта 

и настроек приложения). 

 Задание 3: Использование OLE для создания интерактивных документов: 
o Создайте документ Word, в котором внедрена таблица Excel. 

o Используйте возможности Excel (например, формулы, условное форматирование) 

для создания интерактивной таблицы, которая автоматически изменяется в 

зависимости от введенных данных. 

o Покажите, как можно использовать OLE для создания динамических отчетов и 

презентаций. 

 Задание 4: OLE и безопасность: 
o Обсудите потенциальные риски безопасности, связанные с использованием OLE 

(например, внедрение вредоносных объектов). 

o Изучите, какие меры безопасности предусмотрены в Microsoft Office для защиты 

от таких рисков. 

Практическая работа № 11-12. Работа с таблицами 



Задание 1: Создание таблицы 

 Шаг 1: Создание таблицы "вручную": 
o Откройте MS Word. 

o Перейдите на вкладку "Вставка" -> "Таблица" -> "Вставить таблицу…". 

o Укажите количество строк и столбцов (например, 5 строк и 3 столбца) и нажмите 

"ОК". 

 Шаг 2: Создание таблицы "рисованием": 
o Перейдите на вкладку "Вставка" -> "Таблица" -> "Нарисовать таблицу". 

o Нарисуйте границы таблицы, а затем линии для строк и столбцов. Попробуйте 

создать таблицу сложной формы (например, с объединенными ячейками). 

 Шаг 3: Преобразование текста в таблицу: 
o Наберите текст, разделяя столбцы, например, символом табуляции или запятой: 

ФИО Должность Зарплата Иванов И.И. Менеджер 60000 Петров П.П. Бухгалтер 

50000 Сидоров С.С. Программист 70000  

o Выделите этот текст. 

o Перейдите на вкладку "Вставка" -> "Таблица" -> "Преобразовать в таблицу". 

o В диалоговом окне укажите символ-разделитель (табуляция или запятая) и 

нажмите "ОК". 

 Шаг 4: Использование экспресс-таблиц: 
o Перейдите на вкладку "Вставка" -> "Таблица" -> "Экспресс-таблицы". 

o Выберите одну из готовых таблиц (например, "Календарь") и вставьте ее в 

документ. 

 Шаг 5: Заполнение таблицы данными: 
o После создания таблицы любым из способов, заполните ее осмысленной 

информацией (например, список сотрудников с их данными, расписание занятий, 

результаты соревнований и т.д.). 

Задание 2: Редактирование структуры таблицы 

 Шаг 1: Добавление и удаление строк и столбцов: 
o Установите курсор в любую ячейку таблицы. 

o Используйте контекстное меню (правый клик) или вкладку "Макет" (в группе 

"Работа с таблицами") для добавления строк сверху/снизу и столбцов слева/справа. 

o Удалите строку или столбец, используя контекстное меню или вкладку "Макет". 

 Шаг 2: Объединение и разделение ячеек: 
o Выделите несколько ячеек, которые нужно объединить. 

o Используйте контекстное меню или вкладку "Макет" -> "Объединить ячейки". 

o Разделите объединенную ячейку на несколько ячеек, используя контекстное меню 

или вкладку "Макет" -> "Разделить ячейки". Укажите количество строк и столбцов 

для разделения. 

 Шаг 3: Изменение высоты строк и ширины столбцов: 
o Измените высоту строки, перетаскивая границу строки мышью. 

o Измените ширину столбца, перетаскивая границу столбца мышью. 

o Используйте вкладку "Макет" -> "Размер ячейки" для точной настройки высоты 

строк и ширины столбцов. 

o Используйте функцию "Автоподбор", чтобы автоматически настроить ширину 

столбцов под содержимое ячеек. 

 Шаг 4: Разделение таблицы: 
o Установите курсор в строку, с которой нужно начать новую таблицу. 

o На вкладке "Макет" выберите "Разделить таблицу". (Или Ctrl+Shift+Enter). 



Задание 3: Форматирование таблицы 

 Шаг 1: Изменение стилей таблицы: 
o Выделите таблицу. 

o Перейдите на вкладку "Конструктор" (в группе "Работа с таблицами"). 

o Выберите один из готовых стилей таблицы. Поэкспериментируйте с различными 

стилями. 

o Настройте параметры стиля (например, "Строка заголовка", "Чередующиеся 

строки", "Первый столбец", "Последний столбец") для изменения внешнего вида 

таблицы. 

 Шаг 2: Форматирование текста в ячейках: 
o Выделите текст в одной или нескольких ячейках. 

o Используйте стандартные инструменты форматирования текста (шрифт, размер, 

начертание, цвет, выравнивание) на вкладке "Главная". 

 Шаг 3: Заливка и границы ячеек: 
o Выделите ячейки, которые нужно отформатировать. 

o Используйте кнопку "Заливка" на вкладке "Конструктор" или вкладке "Главная" -> 

"Заливка" для изменения цвета фона ячеек. 

o Используйте кнопку "Границы" на вкладке "Конструктор" или вкладке "Главная" -

> "Границы" для изменения стиля, толщины и цвета границ ячеек. Попробуйте 

убрать некоторые границы или добавить диагональные линии. 

 Шаг 4: Изменение направления текста в ячейке: 
o Выделите ячейку(и). 

o На вкладке "Макет" в группе "Выравнивание" найдите кнопку "Направление 

текста". Пощелкайте её, чтобы изменить направление текста. 

Задание 4: Формулы в таблицах Word 

 Шаг 1: Суммирование значений в столбце: 
o Создайте таблицу с числовыми данными (например, таблицу расходов по 

категориям). 

o Потовить ячейку, в которой нужно отобразить сумму. 

o Перейдите на вкладку "Макет" -> "Формула". 

o В диалоговом окне введите формулу =SUM(ABOVE) (для суммирования значений 

над текущей ячейкой) или =SUM(LEFT) (для суммирования значений слева от 

текущей ячейки). 

o Выберите формат числа (например, "#,##0.00") и нажмите "ОК". 

 Шаг 2: Расчет среднего значения: 
o Повторите шаги из предыдущего задания, но используйте формулу 

=AVERAGE(ABOVE) или =AVERAGE(LEFT). 

 Шаг 3: Использование других функций: 
o Попробуйте использовать другие функции Word (например, PRODUCT - 

произведение, MAX - максимальное значение, MIN - минимальное значение, 

COUNT - количество значений). 

Дополнительные задания: 

 Задание 5: Вложенные таблицы: Создайте таблицу внутри другой таблицы. 

 Задание 6: Связь таблицы Word с данными из Excel (OLE). Опишите, как можно 

вставить таблицу Excel в Word как связанный объект и чем это отличается от простого 

копирования. 



 Задание 7: Создание оглавления таблицы: Если у вас в документе много таблиц, 

изучите, как создать оглавление таблиц (если такая функция есть в вашей версии 

Word). 

 

Практическая работа № 13-14. Создание и форматирование таблиц 

1. Цель работы: Освоение навыков создания и форматирования таблиц в MS Word 

для эффективного представления данных. 

Задачи работы: (Конкретные шаги, которые студент должен выполнить) 

 Создание таблиц различными способами. 

 Редактирование структуры таблицы (добавление/удаление строк/столбцов, 

объединение/разделение ячеек). 

 Форматирование таблиц и ячеек (стили, границы, заливка, шрифты, 

выравнивание). 

 Использование основных операций с таблицами (сортировка, преобразование в 

текст и наоборот). 

o Используемые инструменты: MS Word (версия, если это важно) 

2. Основная часть: 

Задание 1: Создание таблиц различными способами 

o Цель: Научиться создавать таблицы в MS Word, используя различные методы. 

o Шаги: 

1. Создание таблицы через меню "Вставка" -> "Таблица": 
 Опишите, как создать таблицу, указав количество строк и столбцов. 

 Скриншот: Вставка таблицы с заданным количеством строк и столбцов. 

 Заполните таблицу фиктивными данными (минимум 3 строки и 3 столбца). 

Пример: "ФИО", "Предмет", "Оценка". 

 Скриншот: Заполненная таблица. 

2. Создание таблицы "рисованием": 
 Объясните, как использовать инструмент "Нарисовать таблицу" для 

создания таблицы произвольной формы. 

 Создайте таблицу с нестандартной структурой (например, с 

объединенными ячейками в разных местах). 

 Скриншот: Таблица, созданная с помощью инструмента "Нарисовать 

таблицу". 

3. Преобразование текста в таблицу: 
 Создайте текстовый фрагмент, разделенный знаками табуляции или 

запятыми (как в предыдущих примерах про сотрудников). 

 Опишите, как преобразовать текст в таблицу, указав символ-разделитель. 

 Скриншот: Исходный текст и таблица, полученная после преобразования. 

4. Использование "Экспресс-таблиц": 
 Покажите, как вставить готовую экспресс-таблицу (например, календарь). 

 Скриншот: Вставленная экспресс-таблица. 

o Вывод: Краткое описание преимуществ и недостатков каждого способа создания 

таблицы. Когда какой способ лучше использовать? (Например, "Создание таблицы 

через меню удобно для простых таблиц, а рисование - для таблиц сложной 

структуры"). 

Задание 2: Редактирование структуры таблицы 



o Цель: Освоить навыки изменения структуры таблиц (добавление/удаление 

строк/столбцов, объединение/разделение ячеек). 

o Шаги: 

0. Добавление строк и столбцов: 
 Создайте таблицу. 

 Опишите, как добавлять строки сверху, снизу, столбцы слева, справа 

(используя контекстное меню и вкладку "Макет"). 

 Скриншоты: Процесс добавления строки/столбца. 

1. Удаление строк и столбцов: 
 Опишите, как удалять строки и столбцы (контекстное меню, вкладка 

"Макет"). 

 Скриншоты: Процесс удаления строки/столбца. 

2. Объединение и разделение ячеек: 
 Объясните, как объединять несколько ячеек в одну. 

 Объясните, как разделять ячейку на несколько строк/столбцов. 

 Скриншоты: Примеры объединения и разделения ячеек. 

3. Разделение таблицы: 
 Объясните, как разделить таблицу на две отдельные таблицы. 

 Скриншот: Разделенная таблица. 

o Вывод: Подчеркните, что умение изменять структуру таблицы позволяет 

адаптировать ее под конкретные нужды. 

Задание 3: Форматирование таблицы 

o Цель: Освоить основные приемы форматирования таблиц в MS Word. 

o Шаги: 

0. Применение стилей таблицы: 
 Создайте таблицу. 

 Покажите, как применять готовые стили таблицы (вкладка "Конструктор"). 

 Скриншоты: Таблица с разными стилями. 

 Опишите, как настраивать параметры стиля (например, "Строка заголовка", 

"Чередующиеся строки"). 

1. Форматирование текста в ячейках: 
 Покажите, как изменять шрифт, размер, начертание, цвет текста, 

выравнивание текста (используя вкладку "Главная"). 

 Скриншоты: Таблица с отформатированным текстом. 

2. Границы и заливка ячеек: 
 Опишите, как изменять цвет фона ячеек (заливка). 

 Опишите, как изменять стиль, толщину и цвет границ таблицы и отдельных 

ячеек. 

 Скриншоты: Таблица с измененными границами и заливкой. Примеры: 

убрать внешние границы, сделать границы только для строки заголовков, 

залить строку заголовков цветом. 

3. Изменение высоты строк и ширины столбцов: 
 Опишите, как изменять высоту строк и ширину столбцов мышью и с 

помощью вкладки "Макет" (точное значение). 

 Покажите, как использовать функцию "Автоподбор". 

 Скриншоты: Измененные высота строк и ширина столбцов. 

4. Выравнивание текста в ячейках (vertical alignment): 
 Опишите, как выравнивать текст по вертикали (верх, центр, низ) и по 

горизонтали (лево, центр, право) 



o Вывод: Подчеркните важность форматирования для улучшения восприятия 

информации в таблицах. 

Задание 4: Операции с таблицами 

o Цель: Изучить некоторые операции, которые можно выполнять с таблицами. 

o Шаги: 

0. Сортировка данных в таблице: 
 Создайте таблицу с данными, которые можно отсортировать. 

 Опишите, как отсортировать данные по одному или нескольким столбцам 

(вкладка "Макет" -> "Сортировка"). 

 Скриншоты: Таблица до и после сортировки. 

1. Преобразование таблицы в текст: 
 Опишите, как преобразовать таблицу в текст, указав символ-разделитель. 

 Скриншоты: Таблица и текст, полученный после преобразования. 

 

Практическая работа № 15-16. Работа с формулами 

1. Введение:  
o Актуальность: Описание случаев, когда использование формул в Word может быть 

полезным (например, расчет простых финансовых отчетов, итоговых таблиц). 

o Цель работы: Освоение навыков использования формул для выполнения расчетов в 

таблицах MS Word. 

o Задачи работы: 

 Изучение синтаксиса формул в Word. 

 Освоение основных функций (SUM, AVERAGE, PRODUCT, MAX, MIN, 

COUNT). 

 Использование ссылок на ячейки в формулах. 

 Форматирование результатов вычислений. 

o Используемые инструменты: MS Word. 

2. Основная часть:  

Задание 1: Базовые арифметические операции и функция SUM 

o Цель: Научиться использовать основные арифметические операции и функцию 

SUM для суммирования данных в таблице. 

o Шаги: 

1. Создание таблицы: 
 Создайте таблицу с числовыми данными (например, таблица расходов, 

таблица продаж). Минимум 3 столбца и 4 строки данных. Один столбец - 

"Наименование товара/услуги", остальные столбцы - числовые данные 

(например, "Цена", "Количество", "Сумма"). 

 Скриншот: Созданная таблица с данными. 

2. Суммирование столбца: 
 Установите курсор в ячейку, где нужно получить сумму столбца (например, 

в ячейку "Итого"). 

 Перейдите на вкладку "Макет" (в группе "Работа с таблицами") и нажмите 

кнопку "Формула". 

 В окне "Формула" проверьте правильность формулы. Для суммирования 

значений над текущей ячейкой используйте =SUM(ABOVE). 

 Выберите формат числа (например, "#,##0.00" для денежного формата). 



 Нажмите "ОК". 

 Скриншоты: Окно "Формула", результат суммирования. 

3. Суммирование строки: 
 Аналогично, создайте столбец "Итого" в конце таблицы. 

 Установите курсор в ячейку, где нужно получить сумму строки. 

 В окне "Формула" используйте =SUM(LEFT) для суммирования значений 

слева от текущей ячейки. 

 Скриншоты: Формула для суммирования строки, результат суммирования. 

4. Использование арифметических операций: 
 Создайте столбец "Прибыль", рассчитанный как "Сумма" - "Затраты". 

 В ячейке столбца "Прибыль" введите формулу =B2-C2 (если "Сумма" 

находится в столбце B, а "Затраты" - в столбце C и текущая строка - 

вторая). 

 Скриншоты: Формула для расчета прибыли, результат. 

Задание 2: Функции AVERAGE, PRODUCT, MAX, MIN, COUNT 

o Цель: Освоить использование других полезных функций в формулах Word. 

o Шаги: 

0. Функция AVERAGE: 
 В таблице из Задания 1 добавьте строку "Среднее значение". 

 Используйте функцию =AVERAGE(ABOVE) для вычисления среднего 

значения каждого столбца. 

 Скриншоты: Формула и результат для AVERAGE. 

1. Функция PRODUCT: 
 Создайте таблицу для расчета общей стоимости нескольких товаров 

(столбцы "Цена", "Количество", "Общая стоимость"). 

 Используйте функцию =PRODUCT(LEFT) или =PRODUCT(A2,B2) для 

расчета "Общей стоимости" как произведения "Цены" и "Количества". 

 Скриншоты: Формула и результат для PRODUCT. 

2. Функции MAX и MIN: 
 В таблице с расходами определите максимальную и минимальную сумму 

расходов, используя функции =MAX(ABOVE) и =MIN(ABOVE). 

 Скриншоты: Формулы и результаты для MAX и MIN. 

3. Функция COUNT: 
 Создайте столбец, где нужно посчитать количество заполненных ячеек 

(например, количество товаров определенного типа). 

 Используйте функцию =COUNT(ABOVE) или =COUNT(LEFT) для 

подсчета. (Обратите внимание, что COUNT считает числовые значения!). 

 Скриншоты: Формула и результат для COUNT. 

Задание 3: Ссылки на ячейки и форматирование результатов 

o Цель: Научиться использовать ссылки на ячейки и правильно форматировать 

результаты вычислений. 

o Шаги: 

0. Использование ссылок на ячейки: 
 Создайте таблицу с данными. 

 Рассчитайте значение в ячейке, используя ссылки на другие ячейки 

(например, =B2*C2*D2). 

 Скриншоты: Пример формулы со ссылками на ячейки. 

1. Форматирование чисел: 



 Используйте форматы чисел (в окне "Формула") для отображения 

денежных значений (например, "#,##0.00 грн"), процентов (например, 

"0%"), и других форматов. 

 Скриншоты: Разные форматы чисел в таблице. 

2. Копирование формул: 
 Опишите, что формулы Word не обновляются автоматически как в Excel. 

 Чтобы применить формулу к другим ячейкам, придётся её копировать и 

редактировать или вставлять заново. Покажите, как это делается. 

 Скриншоты: Процесс копирования и редактирования формулы. 

Задание 4: Условные выражения (если возможно в вашей версии Word) 

o (Опционально, в зависимости от версии Word и возможностей): 
o Цель: (Если возможно) Изучить использование условных выражений в формулах 

Word. 

o Шаги: 

0. Использование функции IF (или аналога): 
 Создайте таблицу, где нужно отобразить разные значения в зависимости от 

условия (например, "Бонус" = 10% от зарплаты, если зарплата > 50000, 

иначе 0). 

 Попробуйте использовать формулу с функцией IF (если она 

поддерживается вашей версией Word). Синтаксис может отличаться от 

Excel! Нужно изучить справку Word. 

 Пример (возможно, потребуется адаптация): =IF(B2>50000, B2*0.1, 0) (если 

зарплата в B2 больше 50000, то 10% от B2, иначе 0). 

 Скриншоты: Попытка использования условной функции, результат (если 

получилось). 

1. Анализ ограничений: 
 Опишите, какие ограничения есть при использовании формул в Word по 

сравнению с Excel. (Например, отсутствие автоматического обновления, 

ограниченный набор функций, сложность работы с условными 

выражениями). 

 

 

Практическая работа № 17-18. Работа с диаграммами 

1. Введение:  
o Актуальность: Объясните важность визуализации данных для анализа и принятия 

решений. Подчеркните роль диаграмм в представлении сложных данных в 

понятной форме. 

o Цель работы: Освоение навыков создания и форматирования диаграмм в MS Excel 

для наглядного представления данных. 

o Задачи работы: 

 Изучение различных типов диаграмм (гистограмма, линейчатая диаграмма, 

круговая диаграмма, график, точечная диаграмма). 

 Создание диаграмм на основе табличных данных. 

 Форматирование диаграмм (изменение заголовков, легенды, осей, подписей 

данных). 

 Настройка макета и стиля диаграммы. 

o Используемые инструменты: MS Excel. 

2. Основная часть:  



Задание 1: Создание основных типов диаграмм 

o Цель: Научиться создавать основные типы диаграмм в Excel (гистограмма, 

линейчатая, круговая, график). 

o Шаги: 

1. Гистограмма (столбчатая диаграмма): 
 Создайте таблицу с данными, подходящими для гистограммы (например, 

объем продаж по месяцам, количество студентов по специальностям). 

Минимум 3 столбца (категории, значения, возможно, дополнительные 

серии данных) и 5 строк данных. 

 Выделите диапазон ячеек с данными. 

 Перейдите на вкладку "Вставка" и в группе "Диаграммы" выберите 

"Гистограмма". 

 Выберите один из подтипов гистограммы (например, "Гистограмма с 

группировкой", "Гистограмма с накоплением"). 

 Скриншоты: Таблица с данными, вставленная гистограмма. 

2. Линейчатая диаграмма: 
 Используйте те же данные, что и для гистограммы, или создайте новые. 

 Выберите "Линейчатая диаграмма" на вкладке "Вставка". 

 Выберите подтип (например, "Линейчатая с группировкой", "Линейчатая с 

накоплением"). 

 Скриншоты: Созданная линейчатая диаграмма. 

3. Круговая диаграмма: 
 Создайте таблицу с данными, представляющими доли целого (например, 

распределение бюджета по статьям расходов, доли рынка, занимаемые 

разными компаниями). Важно, чтобы сумма всех значений составляла 100% 

или была легко суммируемой. 

 Выберите "Круговая диаграмма" на вкладке "Вставка". 

 Выберите подтип (например, "Круговая", "Объемная круговая"). 

 Скриншоты: Созданная круговая диаграмма. 

4. График (линейная диаграмма): 
 Создайте таблицу с данными, показывающими изменение значений во 

времени (например, курс валюты, температура за период, посещаемость 

сайта по дням). Обязательно наличие оси времени (дата, месяц, год). 

 Выберите "График" на вкладке "Вставка". 

 Выберите подтип (например, "График", "График с маркерами"). 

 Скриншоты: Созданный график. 

Задание 2: Форматирование диаграмм 

o Цель: Научиться форматировать диаграммы, чтобы улучшить их внешний вид и 

читаемость. 

o Шаги: 

0. Изменение заголовка диаграммы: 
 Дважды щелкните по заголовку диаграммы и введите новый заголовок, 

отражающий суть данных. 

 Скриншоты: Измененный заголовок диаграммы. 

1. Настройка легенды: 
 Измените положение легенды (справа, слева, сверху, снизу). 

 Измените шрифт и размер текста в легенде. 

 Удалите легенду, если она не нужна. 

 Скриншоты: Диаграмма с измененной легендой. 



2. Форматирование осей: 
 Измените масштаб осей (минимальное и максимальное значения). 

 Измените шаг сетки. 

 Измените формат чисел на осях (например, добавьте денежный знак или 

проценты). 

 Добавьте названия осей. 

 Скриншоты: Диаграмма с отформатированными осями. 

3. Добавление и форматирование подписей данных: 
 Добавьте подписи данных к элементам диаграммы (значения, проценты, 

названия категорий). 

 Измените положение подписей данных. 

 Измените шрифт и размер текста подписей. 

 Скриншоты: Диаграмма с подписями данных. 

Задание 3: Настройка макета и стиля диаграммы 

o Цель: Научиться настраивать макет и стиль диаграммы для придания ей 

профессионального вида. 

o Шаги: 

0. Изменение макета диаграммы: 
 Используйте вкладку "Конструктор" (в группе "Работа с диаграммами") для 

выбора готовых макетов диаграммы. 

 Скриншоты: Диаграмма с разными макетами. 

1. Изменение стиля диаграммы: 
 Используйте вкладку "Формат" (в группе "Работа с диаграммами") для 

изменения цвета и фона диаграммы, заливки и контура элементов 

диаграммы. 

 Примените готовые стили диаграммы. 

 Скриншоты: Диаграмма с разными стилями. 

2. Изменение типа диаграммы: 
 Попробуйте изменить тип созданной диаграммы на другой (например, 

гистограмму на график). Оцените, как изменилось представление данных. 

 Скриншоты: Диаграмма после смены типа. 

3. Работа с рядами данных: 
 Добавьте новый ряд данных в существующую диаграмму. 

 Измените тип диаграммы для отдельных рядов (например, один ряд - 

гистограмма, другой - график). (Комбинированная диаграмма). 

 Скриншоты: Диаграмма с добавленным рядом данных и комбинированная 

диаграмма. 

Задание 4: Специальные типы диаграмм (опционально, в зависимости от уровня 

подготовки) 

o Цель: Познакомиться с некоторыми специальными типами диаграмм. 

o Шаги: 

0. Точечная диаграмма (диаграмма рассеяния): 
 Создайте таблицу с двумя наборами числовых данных, представляющих 

координаты точек. 

 Выберите "Точечная диаграмма" на вкладке "Вставка". 

 Скриншоты: Созданная точечная диаграмма. (Пример: зависимость роста 

от веса, зависимость результатов теста от времени подготовки). 

1. Лепестковая диаграмма: 



 Создайте таблицу с данными для нескольких категорий и нескольких 

объектов. 

 Выберите "Лепестковая диаграмма" на вкладке "Вставка". 

 Скриншоты: Созданная лепестковая диаграмма. (Пример: сравнение 

характеристик разных моделей техники). 

2. Другие типы диаграмм: 
 Кратко опишите другие типы диаграмм, доступные в Excel (например, 

"Биржевая", "Поверхность", "Гистограмма с областями"). 

 

 

Практическая работа № 19-20. Ретушь изображения 

Введение  

 Актуальность: Опишите важность ретуши в современной фотографии (для портретов, 

рекламы, дизайна и т.д.). 

 Цель работы: Освоить основные техники ретуши изображений в Adobe Photoshop. 

 Задачи работы: 

o Удаление дефектов кожи (прыщи, морщины, шрамы). 

o Улучшение тона и цвета кожи. 

o Коррекция формы лица и фигуры (минимальная). 

o Улучшение резкости и детализации. 

o Общая цветокоррекция и тонирование изображения. 

 Используемые инструменты: Adobe Photoshop. 

 Исходные изображения: Опишите откуда взяты изображения (личные фото, стоковые 

сайты и т.д.). Укажите, что вам разрешено использовать эти изображения для учебных 

целей. 

3. Основная часть  

Важно: Для каждого задания обязательно предоставьте скриншоты: 

 Исходного изображения (до ретуши). 

 Промежуточные этапы работы (где это необходимо). 

 Итогового изображения (после ретуши). 

 Скриншоты с указанием используемых инструментов и настроек. 

Задание 1: Базовая ретушь кожи (Удаление дефектов) 

 Цель: Научиться удалять мелкие дефекты кожи (прыщи, родинки, мелкие царапины) с 

использованием инструментов "Healing Brush", "Spot Healing Brush" и "Patch Tool". 

 Шаги: 
1. Откройте изображение портрета с видимыми дефектами кожи. 

2. Healing Brush Tool (Восстанавливающая кисть): 
 Создайте новый слой (для неразрушающей ретуши). 

 Выберите инструмент "Healing Brush Tool". 

 Удерживая клавишу Alt, щелкните на участке кожи рядом с дефектом, чтобы 

выбрать образец. 

 Закрасьте дефект. 

 Скриншоты: Выбранный инструмент, настройки кисти, результат работы. 

3. Spot Healing Brush Tool (Точечная восстанавливающая кисть): 



 Создайте новый слой. 

 Выберите инструмент "Spot Healing Brush Tool". 

 Убедитесь, что в настройках выбрано "Content-Aware" (с учетом содержимого). 

 Щелкните по дефекту или закрасьте его. 

 Скриншоты: Выбранный инструмент, настройки, результат работы. 

4. Patch Tool (Заплатка): 
 Создайте новый слой. 

 Выберите инструмент "Patch Tool". 

 Обведите дефект. 

 Перетащите выделенную область на чистый участок кожи для замены дефекта. 

 Скриншоты: Выбранный инструмент, процесс выделения и замены дефекта. 

5. Оцените результат и при необходимости повторите шаги с другими дефектами. 

Сравните "до" и "после". 

 Важно: Работайте аккуратно, чтобы не размыть текстуру кожи. 

Задание 2: Выравнивание тона кожи и смягчение морщин 

 Цель: Научиться выравнивать тон кожи и смягчать морщины, сохраняя естественную 

текстуру. Использование техники "Frequency Separation" (Разложение частот). 

 Шаги: 
1. Откройте изображение портрета. 

2. Frequency Separation: 

 Дублируйте слой. 
 High Frequency Layer (Слой высоких частот): Примените фильтр "High Pass" 

(Другое > High Pass). Выберите радиус (обычно от 2 до 4 пикселей) до тех пор, 

пока детали текстуры кожи (поры, мелкие морщинки) не станут видны на 

сером фоне. Нажмите "ОК". Измените режим наложения этого слоя на "Linear 

Light" или "Overlay". 

 Скриншоты: Окно фильтра High Pass, результат применения фильтра, 

режим наложения слоя. 

 Low Frequency Layer (Слой низких частот): Выберите нижний слой 

(дубликат исходного изображения). Примените фильтр "Gaussian Blur" 

(Размытие > Размытие по Гауссу). Выберите радиус размытия (обычно от 4 до 

8 пикселей) до тех пор, пока не исчезнут резкие переходы тона, но основные 

контуры лица должны оставаться видимыми. 

 Скриншоты: Окно фильтра Gaussian Blur, результат применения фильтра. 

3. Ретушь на слое низких частот: 
 Выберите слой низких частот. Используйте инструмент "Mixer Brush Tool" 

(Кисть смешивания) или "Blur Tool" (Размытие) с очень низкой 

интенсивностью для сглаживания неровностей тона кожи и смягчения морщин. 

 Скриншоты: Настройки Mixer Brush Tool или Blur Tool, результат работы. 

4. Ретушь на слое высоких частот: 
 Выберите слой высоких частот. Используйте инструменты "Healing Brush Tool" 

или "Clone Stamp Tool" для удаления оставшихся мелких дефектов или 

артефактов, появившихся после размытия. 

 Скриншоты: Использование Healing Brush Tool или Clone Stamp Tool на слое 

высоких частот. 

5. Отрегулируйте непрозрачность слоев высоких и низких частот для достижения 

наилучшего результата. 

6. Сравните "до" и "после". 

Задание 3: Коррекция цвета кожи и тонирование 



 Цель: Научиться корректировать цвет кожи и придавать изображению желаемый 

оттенок с использованием корректирующих слоев. 

 Шаги: 
1. Откройте изображение портрета. 

2. Color Balance (Цветовой баланс): 
 Создайте корректирующий слой "Color Balance". 

 Скорректируйте цвета в тенях, средних тонах и светах, чтобы добиться более 

естественного и здорового оттенка кожи. (Например, уменьшить излишнюю 

красноту или добавить теплоты). 

 Скриншоты: Окно Color Balance, настройки, результат работы. 

3. Selective Color (Выборочный цвет): 
 Создайте корректирующий слой "Selective Color". 

 Выберите канал "Reds" (Красные) и скорректируйте значения Cyan, Magenta, 

Yellow и Black, чтобы улучшить цвет губ и щек. 

 Аналогично скорректируйте другие цвета (например, "Yellows" для кожи). 

 Скриншоты: Окно Selective Color, настройки, результат работы. 

4. Curves (Кривые) или Levels (Уровни): 
 Создайте корректирующий слой "Curves" или "Levels". 

 Скорректируйте общую яркость и контраст изображения. Можно слегка 

затемнить света и осветлить тени для более сбалансированного тона. 

 Скриншоты: Окно Curves или Levels, настройки, результат работы. 

5. Gradient Map (Градиентная карта): (Опционально, для тонирования) 

 Создайте корректирующий слой "Gradient Map". 

 Выберите градиент, который хотите использовать для тонирования (например, 

от темно-синего к светло-желтому). 

 Измените режим наложения слоя "Gradient Map" на "Soft Light", "Overlay" или 

"Color". 

 Уменьшите непрозрачность слоя для получения мягкого эффекта. 

 Скриншоты: Окно Gradient Map, выбранный градиент, режим наложения, 

результат работы. 

6. Сравните "до" и "после". 

Задание 4: Улучшение резкости и детализации 

 Цель: Научиться улучшать резкость и детализацию изображения, не создавая 

артефактов. 

 Шаги: 
1. Откройте изображение портрета. 

2. Unsharp Mask (Нерезкая маска): 
 Дублируйте слой с исходным изображением. 

 Примените фильтр "Unsharp Mask" (Фильтр > Усиление резкости > Unsharp 

Mask). 

 Установите небольшое значение "Amount" (обычно от 30% до 70%), небольшой 

радиус "Radius" (обычно от 0.5 до 1.0 пикселя) и "Threshold" (обычно 0). 

 Скриншоты: Окно Unsharp Mask, настройки, результат работы. 

3. High Pass (Высокий проход): (Альтернативный метод) 

 Дублируйте слой с исходным изображением. 

 Примените фильтр "High Pass" (Другое > High Pass) с небольшим радиусом (1-

2 пикселя). 

 Измените режим наложения слоя на "Overlay" или "Soft Light". 

 Добавьте маску слоя и мягкой кистью пройдитесь по тем областям, где не 

хотите усиливать резкость (например, кожа). 



 Скриншоты: Окно High Pass,настройки, режим наложения, результат работы. 

4. Сравните "до" и "после". 

Задание 5: Общая цветокоррекция и финальная обработка 

 Цель: Выполнить общую цветокоррекцию изображения и применить финальные 

штрихи. 

 Шаги: 
1. Создайте корректирующие слои "Curves", "Levels", "Brightness/Contrast" для 

окончательной настройки тона и контраста. 

2. Используйте корректирующий слой "Vibrance" для усиления насыщенности 

цветов, делая изображение более живым. 

3. Примените фильтр "Camera Raw Filter" (Фильтр > Camera Raw Filter) для тонкой 

настройки экспозиции, контраста, теней, светов, резкости и цветовой температуры. 

(Этот фильтр дает большой контроль над изображением). 

4. При необходимости добавьте виньетирование (затемнение углов) для 

акцентирования внимания на центре изображения (Camera Raw Filter -> Effects -> 

Vignette). 

5. Выполните финальную проверку изображения на наличие дефектов или 

артефактов. 

6. Сохраните изображение в формате JPG с высоким качеством. 

 

 

Практическая работа № 21-22. Работа с фильтрами 

1. Введение  

 Актуальность: Опишите роль фильтров в Photoshop для создания креативных 

эффектов, стилизации изображений и коррекции дефектов. 

 Цель работы: Освоить применение различных фильтров в Adobe Photoshop для 

обработки изображений. 

 Задачи работы: 

o Изучение основных категорий фильтров (размытие, резкость, искажение, 

стилизация, шум и т.д.). 

o Применение фильтров для создания различных эффектов (размытие, усиление 

резкости, имитация живописи, создание текстур). 

o Использование фильтров с масками слоев для локальной обработки изображений. 

o Применение смарт-фильтров для неразрушающей фильтрации. 

o Экспериментирование с настройками фильтров для достижения желаемого 

результата. 

 Используемые инструменты: Adobe Photoshop. 

 Исходные изображения: Опишите откуда взяты изображения (личные фото, стоковые 

сайты и т.д.). Укажите, что вам разрешено использовать эти изображения для учебных 

целей. 

2. Основная часть  

Важно: Для каждого задания обязательно предоставьте скриншоты: 

 Исходного изображения (до применения фильтра). 

 Окна настроек фильтра (с указанными параметрами). 



 Итогового изображения (после применения фильтра). 

 Скриншоты с масками слоев (если используются). 

Задание 1: Фильтры размытия (Blur) 

 Цель: Научиться использовать фильтры размытия для создания эффекта глубины 

резкости, смягчения деталей и добавления движения. 

 Шаги: 
1. Откройте изображение (например, пейзаж или портрет). 

2. Gaussian Blur (Размытие по Гауссу): 
 Дублируйте слой. 

 Выберите "Filter" > "Blur" > "Gaussian Blur". 

 Установите радиус размытия (в пикселях) и наблюдайте за изменением 

изображения. 

 Примените маску слоя и кистью с мягкими краями удалите размытие с тех 

областей, которые должны оставаться резкими (например, основной объект на 

переднем плане). 

 Скриншоты: Окно Gaussian Blur, настройки, результат размытия, маска слоя. 

3. Motion Blur (Размытие в движении): 
 Дублируйте слой. 

 Выберите "Filter" > "Blur" > "Motion Blur". 

 Установите угол и расстояние размытия. 

 Этот фильтр хорошо подходит для создания эффекта скорости (например, для 

автомобиля). 

 Скриншоты: Окно Motion Blur, настройки, результат размытия. 

4. Field Blur (Размытие поля): 
 Выберите "Filter" > "Blur Gallery" > "Field Blur". 

 Щелкните в разных областях изображения, чтобы добавить точки размытия. 

Для каждой точки можно настроить степень размытия. 

 Этот фильтр позволяет создавать сложный эффект глубины резкости. 

 Скриншоты: Интерфейс Field Blur, точки размытия, настройки, результат. 

5. Iris Blur (Размытие диафрагмы): 
 Выберите "Filter" > "Blur Gallery" > "Iris Blur". 

 Позволяет создать эффект размытия вокруг эллиптической области, имитируя 

эффект диафрагмы камеры. 

 Скриншоты: Интерфейс Iris Blur, эллиптическая область, настройки, результат. 

6. Tilt-Shift (Наклон-сдвиг): 
 Выберите "Filter" > "Blur Gallery" > "Tilt-Shift". 

 Имитирует эффект, получаемый с помощью объектива tilt-shift, создавая узкую 

полосу резкости. 

 Скриншоты: Интерфейс Tilt-Shift, полоса резкости, настройки, результат. 

Задание 2: Фильтры усиления резкости (Sharpen) 

 Цель: Научиться использовать фильтры усиления резкости для повышения 

детализации и четкости изображений. 

 Шаги: 
1. Откройте изображение (например, фотографию с недостаточной резкостью). 

2. Unsharp Mask (Нерезкая маска): 
 Дублируйте слой. 

 Выберите "Filter" > "Sharpen" > "Unsharp Mask". 



 Установите значения "Amount", "Radius" и "Threshold". Важно не 

переусердствовать, чтобы не создать артефакты. 

 Скриншоты: Окно Unsharp Mask, настройки, результат. 

3. Sharpen (Увеличение резкости): 
 Дублируйте слой. 

 Выберите "Filter" > "Sharpen" > "Sharpen". Простой фильтр, который 

автоматически увеличивает резкость. Может быть полезен для небольшого 

увеличения резкости. 

4. Smart Sharpen (Умная резкость): 
 Дублируйте слой. 

 Выберите "Filter" > "Sharpen" > "Smart Sharpen". 

 Предоставляет больше контроля над параметрами резкости, включая 

уменьшение шума. Поэкспериментируйте с разными режимами (например, 

"Lens Blur"). 

 Скриншоты: Окно Smart Sharpen, настройки, результат. 

Задание 3: Фильтры стилизации (Stylize) 

 Цель: Научиться использовать фильтры стилизации для создания художественных 

эффектов и преображения изображений. 

 Шаги: 
1. Откройте изображение (например, портрет или пейзаж). 

2. Oil Paint (Масляная краска): 
 Выберите "Filter" > "Stylize" > "Oil Paint". 

 Позволяет имитировать эффект масляной живописи. Настройте параметры 

"Stylization", "Cleanliness", "Scale" и "Bristle Detail". 

 Скриншоты: Окно Oil Paint, настройки, результат. 

3. Find Edges (Выделение краев): 
 Выберите "Filter" > "Stylize" > "Find Edges". 

 Выделяет контуры объектов на изображении. Можно использовать для 

создания абстрактных эффектов или для подготовки изображения к 

дальнейшей обработке. 

 Скриншоты: Результат применения фильтра. 

4. Glowing Edges (Светящиеся края): 
 Выберите "Filter" > "Stylize" > "Glowing Edges". 

o Создает эффект светящихся контуров. 

 Sкриншоты: Результат применения фильтра. 

6. Diffuse (Диффузия): 
 Выберите "Filter" > "Stylize" > "Diffuse". 

 Размывает изображение, смешивая цвета. Поэкспериментируйте с разными 

режимами диффузии. Можно использовать для создания мягкого, 

мечтательного эффекта. 

 Скриншоты: Результат применения фильтра. 

Задание 4: Фильтры искажения (Distort) 

 Цель: Научиться использовать фильтры искажения для деформации изображений и 

создания сюрреалистичных эффектов. 

 Шаги: 
1. Откройте изображение (например, архитектурный пейзаж). 

2. Wave (Волна): 
 Выберите "Filter" > "Distort" > "Wave". 



 Создает волнообразные искажения. Настройте параметры "Number of 

Generators", "Wavelength", "Amplitude" и "Scale". 

 Скриншоты: Окно Wave, настройки, результат. 

3. Spherize (Сферизация): 
 Выберите "Filter" > "Distort" > "Spherize". 

 Искажает изображение, как будто оно находится на поверхности сферы. 

 Скриншоты: Результат применения фильтра. 

4. Twirl (Скручивание): 
 Выберите "Filter" > "Distort" > "Twirl". 

 Закручивает изображение вокруг центра. 

 Скриншоты: Результат применения фильтра. 

5. Ripple (Рябь): 
 Выберите "Filter" > "Distort" > "Ripple". 

 Создает эффект ряби на воде. 

 Скриншоты: Результат применения фильтра. 

6. Pinch (Сжатие): 
 Выберите "Filter" > "Distort" > "Pinch". 

 Сжимает или растягивает изображение к центру. 

 Скриншоты: Результат применения фильтра. 

7. Shear (Сдвиг): 
o Выберите "Filter" > "Distort" > "Shear". 

o Искажает изображение вдоль кривой. 

o Скриншоты: Окно Shear, настройки, результат. 

Задание 5: Смарт-фильтры (Smart Filters) и маски слоев 

 Цель: Научиться использовать смарт-фильтры для неразрушающей фильтрации и 

маски слоев для локального применения фильтров. 

 Шаги: 
1. Откройте изображение. 

2. Преобразуйте слой в смарт-объект: "Layer" > "Smart Objects" > "Convert to Smart 

Object". 

3. Примените любой фильтр к смарт-объекту. Фильтр автоматически станет смарт-

фильтром. 

4. Дважды щелкните по названию смарт-фильтра в панели слоев, чтобы изменить его 

настройки. 

5. Добавьте маску слоя к смарт-фильтру (щелкните по значку маски рядом с 

названием фильтра). 

6. Закрасьте маску черным цветом в тех областях, где вы не хотите, чтобы фильтр 

применялся. 

7. Скриншоты: Панель слоев со смарт-объектом и смарт-фильтром, маска слоя. 

Задание 6: Эксперименты и создание собственных эффектов 

 Цель: Применить полученные знания для создания уникального эффекта с 

использованием комбинации нескольких фильтров и техник. 

 Шаги: 
1. Откройте изображение. 

2. Используйте любые фильтры, корректирующие слои и маски слоев для создания 

интересного и оригинального эффекта. 

3. Опишите процесс создания эффекта (какие фильтры и настройки использовались). 

4. Скриншоты: Все этапы создания эффекта, итоговый результат. 



3. Заключение 

 Краткое обобщение выполненных заданий и полученных навыков. 

 Оценка эффективности различных фильтров для решения разных задач. 

 Выводы о возможностях Adobe Photoshop для создания художественных эффектов с 

помощью фильтров. 

 Рекомендации по дальнейшему изучению фильтров (например, изучение сторонних 

фильтров и плагинов). 

 Какие фильтры оказались наиболее полезными/интересными и почему? 

 

Практическая работа № 23-24. Создание мультимедийных презентаций 

Цель работы: Освоить навыки разработки и создания эффективной мультимедийной 

презентации с использованием программного обеспечения (PowerPoint, Google Slides, 

Keynote или аналогичного). 

Задачи: 

1. Выбор темы: Определить актуальную и интересную тему для презентации, 

соответствующую учебной программе. 

2. Анализ аудитории: Определить целевую аудиторию презентации и адаптировать 

содержание и стиль под ее потребности. 

3. Структурирование информации: Разработать логичную структуру презентации, 

включающую введение, основную часть и заключение. 

4. Создание контента: Подготовить текстовый, графический, аудио- и видеоматериал 

для презентации. 

5. Дизайн слайдов: Разработать визуально привлекательный и информативный дизайн 

слайдов с использованием графических элементов, шрифтов и цветовой палитры. 

6. Использование анимации и переходов: Применить анимационные эффекты и 

переходы между слайдами для повышения интерактивности и вовлеченности 

аудитории. 

7. Оптимизация презентации: Оптимизировать размер файла презентации для удобства 

распространения и просмотра на различных устройствах. 

8. Представление презентации: Подготовить устное сопровождение к презентации и 

представить ее перед аудиторией. 

9. Самооценка и анализ: Оценить эффективность созданной презентации и выявить 

области для улучшения. 

Этапы выполнения работы: 

Этап 1: Подготовительный  

1. Выбор темы 
o Выберите тему для презентации, соответствующую вашему курсу или предмету. 

Примеры тем: "Современные технологии в обучении", "Экологические проблемы 

моего региона", "История развития искусственного интеллекта", "Влияние 

социальных сетей на культуру", "Перспективы развития возобновляемой 

энергетики". Согласуйте тему с преподавателем. 

2. Анализ аудитории 



o Определите, кто будет смотреть вашу презентацию (например, одногруппники, 

преподаватели, ученики школы). Учитывайте их возраст, уровень знаний по теме и 

интересы. 

3. Разработка структуры  
o Составьте подробный план презентации, включающий: 

 Вводный слайд (название, ФИО, группа, дата). 

 Цели и задачи презентации (чего вы хотите достичь). 

 Содержание (основные разделы). 

 Основная часть (подробное раскрытие темы, факты, примеры, иллюстрации). 

 Заключение (выводы, обобщение, перспективы). 

 Список литературы. 

o Определите количество слайдов для каждого раздела. 

o Подготовьте краткий текст для каждого слайда (ключевые тезисы). 

4. Сбор материалов  
o Найдите необходимую информацию по теме (тексты, изображения, графики, 

аудио, видео). 

o Используйте надежные источники (научные статьи, книги, официальные сайты). 

o Укажите источники для всех использованных материалов (в конце каждого слайда 

или в списке литературы). 

Этап 2: Основной 

1. Создание слайдов  
o Используя выбранное программное обеспечение (PowerPoint, Google Slides, 

Keynote), создайте слайды в соответствии с разработанным планом. 

o Придерживайтесь следующих рекомендаций: 

 Используйте минимальное количество текста на слайде (только ключевые 

тезисы). 

 Визуализируйте информацию (графики, диаграммы, иллюстрации, 

фотографии). 

 Используйте качественные изображения с высоким разрешением. 

 Оптимизируйте размер изображений для уменьшения размера файла 

презентации. 

 Придерживайтесь единого стиля оформления (цвета, шрифты, расположение 

элементов). 

 Используйте читабельные шрифты (размер шрифта не менее 24 пунктов для 

основного текста и 36 пунктов для заголовков). 

 Проверьте орфографию и пунктуацию. 

2. Добавление анимации и переходов 
o Используйте анимацию и переходы для выделения ключевых моментов и создания 

плавного перехода между слайдами. 

o Не перегружайте презентацию анимационными эффектами – используйте их 

умеренно и целенаправленно. 

3. Оптимизация презентации  
o Сохраните презентацию в формате, совместимом с различными устройствами 

(например, .pptx или .pdf). 

o Сжать изображения для уменьшения размера файла. 

o Проверьте презентацию на различных устройствах (компьютер, проектор). 

Этап 3: Заключительный 

1. Подготовка к защите: продумайте речь к презентации, хронометраж. 



2. Защита презентации. 

3. Анализ и работа над ошибками. 

Критерии оценки: 

 Содержание (40%): 
o Актуальность и соответствие темы заданию. 

o Полнота и достоверность информации. 

o Логичность и структурированность изложения. 

o Качество использованных материалов. 

 Дизайн (30%): 
o Визуальная привлекательность и эстетичность. 

o Единый стиль оформления. 

o Читабельность текста и графики. 

o Уместное использование анимации и переходов. 

 Техническое исполнение (20%): 
o Правильность оформления слайдов. 

o Корректное использование программного обеспечения. 

o Оптимизация размера файла презентации. 

 Представление (10%): 
o Четкость и ясность изложения. 

o Уверенность и владение материалом. 

o Соблюдение регламента времени. 

Форма представления результатов: 

 Презентация в электронном формате (.pptx, .pdf или аналогичном). 

 Краткое письменное описание проделанной работы (1-2 страницы), включающее: 

o Обоснование выбора темы и анализа аудитории. 

o Описание структуры презентации. 

o Перечень использованных источников информации. 

o Самооценка проделанной работы и выводы. 

Рекомендации: 

 Начните работу над презентацией заранее, чтобы у вас было достаточно времени на 

сбор информации, создание слайдов и подготовку к выступлению. 

 Используйте качественные материалы и оформление. 

 Старайтесь сделать презентацию интересной и запоминающейся для аудитории. 

 Не бойтесь экспериментировать и проявлять творчество. 

 

Практическая работа № 25-26. Организация гиперссылок в презентации 

Практическая работа: Организация гиперссылок в презентации 

Цель работы: Освоить навыки создания и эффективной организации гиперссылок в 

мультимедийной презентации для обеспечения нелинейной навигации и дополнительной 

интерактивности. 

Задачи: 



1. Выбор темы и создание структуры презентации: Определить тему презентации и 

разработать ее структуру, включающую введение, основную часть и заключение. 

2. Определение точек гиперссылок: Выявить ключевые моменты в презентации, где 

целесообразно добавить гиперссылки для перехода к дополнительным материалам или 

другим слайдам. 

3. Создание гиперссылок на другие слайды: Настроить гиперссылки для навигации 

между слайдами презентации, обеспечивая нелинейный переход к определенным 

разделам. 

4. Создание гиперссылок на внешние ресурсы: Добавить гиперссылки на внешние 

веб-сайты, документы или другие файлы, связанные с темой презентации. 

5. Создание гиперссылок на конкретные места в документах: (Продвинутый 

уровень) Создать гиперссылки, ведущие к определенным разделам или закладкам в 

связанных документах. 

6. Настройка внешнего вида гиперссылок: Настроить внешний вид гиперссылок 

(цвет, подчеркивание и т.д.) для улучшения читаемости и визуальной 

привлекательности. 

7. Проверка работоспособности гиперссылок: Убедиться в правильности и 

работоспособности всех созданных гиперссылок, протестировав их в режиме 

просмотра презентации. 

8. Создание навигационных кнопок: Разработать и добавить на слайды кнопки 

навигации с гиперссылками для удобного перемещения по презентации. 

9. Оценка эффективности гиперссылок: Оценить, насколько эффективно 

организованы гиперссылки в презентации с точки зрения удобства навигации и 

предоставления дополнительной информации. 

Этапы выполнения работы: 

Этап 1: Подготовка 

1. Выбор темы: Выберите тему для презентации. Пусть это будет небольшая 

презентация, содержащая 5-7 слайдов. Примеры тем: 

o "История развития [выберите любую технологию или концепцию]" 

o "[Название предмета/дисциплины] в повседневной жизни" 

o "Топ-5 [чего угодно, связанного с вашим курсом]" 

2. Создание структуры: Разработайте структуру презентации, включающую: 

o Титульный слайд. 

o Содержание (с гиперссылками на разделы). 

o Основная часть (несколько слайдов с контентом). 

o Заключение. 

Этап 2: Создание гиперссылок  

1. Гиперссылки на слайды  
o На слайде "Содержание" создайте гиперссылки на каждый раздел презентации 

(слайд). Используйте текстовые ссылки или кнопки. 

2. Гиперссылки на внешние ресурсы  
o Найдите два-три внешних ресурса (веб-сайты, статьи, видео и т.д.), которые 

дополняют информацию в вашей презентации. 

o Добавьте на соответствующие слайды гиперссылки на эти ресурсы. Под ссылкой 

кратко опишите, что содержит ресурс. 

3. Навигационные кнопки  



o Создайте кнопки "Вперед", "Назад", "На главную" и разместите их на каждом 

слайде, кроме титульного (можно использовать мастер-слайд). 

o Настройте гиперссылки для этих кнопок. 

Этап 3: Тестирование и оформление  

1. Тестирование  
o Запустите презентацию в режиме просмотра и проверьте работоспособность всех 

гиперссылок. 

o Убедитесь, что все ссылки ведут в правильные места. 

o Проверьте, открываются ли внешние ресурсы в браузере. 

2. Оформление  
o Настройте внешний вид гиперссылок, чтобы они были заметны (например, 

измените цвет или добавьте подчеркивание). 

o Убедитесь, что оформление гиперссылок соответствует общему стилю 

презентации. 

Этап 4: Отчет  

 Подготовьте краткий отчет, описывающий: 

o Выбранную тему презентации. 

o Структуру презентации. 

o Типы использованных гиперссылок и их назначение. 

o Трудности, возникшие в процессе работы. 

o Выводы о эффективности использования гиперссылок в презентациях. 

Критерии оценки: 

 Полнота и корректность гиперссылок (40%): 
o Наличие всех необходимых гиперссылок. 

o Правильность указания адресов и целей гиперссылок. 

o Работоспособность всех гиперссылок. 

 Удобство навигации (30%): 
o Логичность и интуитивность навигации по презентации. 

o Удобство использования навигационных кнопок. 

o Легкость доступа к дополнительным материалам. 

 Качество оформления (20%): 
o Соответствие стиля оформления гиперссылок общему стилю презентации. 

o Различимость гиперссылок на слайдах. 

 Отчет (10%): 
o Полнота и ясность описания проделанной работы. 

o Анализ эффективности использования гиперссылок. 

Форма представления результатов: 

 Презентация в формате .pptx (или аналогичном). 

 Краткий отчет в текстовом формате (.doc, .pdf). 

Рекомендации: 

 Используйте гиперссылки для улучшения навигации и предоставления 

дополнительной информации. 



 Не перегружайте презентацию слишком большим количеством гиперссылок. 

 Проверяйте работоспособность всех гиперссылок перед демонстрацией презентации. 

 Используйте навигационные кнопки для облегчения перемещения по презентации. 

 

Практическая работа № 27-28. Поиск информации в сети Интернет 

Цель работы: Освоить эффективные методы и инструменты поиска информации в сети 

Интернет для решения различных задач. 

Задачи: 

1. Формулирование поисковых запросов: Научиться правильно формулировать 

поисковые запросы с использованием ключевых слов, операторов и фильтров для 

получения наиболее релевантных результатов. 

2. Использование различных поисковых систем: Ознакомиться с различными 

поисковыми системами (Google, Yandex, DuckDuckGo и др.) и их функциональными 

возможностями. 

3. Поиск информации на специализированных ресурсах: Научиться искать 

информацию на специализированных сайтах, базах данных, библиотеках и архивах. 

4. Оценка достоверности и актуальности информации: Определять надежность, 

объективность и актуальность найденной информации. 

5. Использование инструментов расширенного поиска: Освоить продвинутые 

инструменты поиска, такие как поиск по типу файла, по дате, по языку и т.д. 

6. Сохранение и организация найденной информации: Научиться сохранять и 

организовывать найденную информацию для дальнейшего использования в проектах, 

исследованиях или учебе. 

7. Использование инструментов для отслеживания изменений: (Продвинутый 

уровень) Использовать инструменты для отслеживания изменений на веб-сайтах и 

получения уведомлений об обновлениях. 

8. Соблюдение авторских прав и правил цитирования: Уметь правильно цитировать 

найденную информацию и соблюдать авторские права при ее использовании. 

Этапы выполнения работы: 

Этап 1: Теоретическая подготовка 

1. Ознакомление с основными принципами поиска: 
o Прочитайте информацию о поисковых системах, ключевых словах, операторах 

поиска ("AND", "OR", "NOT", кавычки), фильтрах и специализированных 

ресурсах. 

2. Выбор поисковых систем: 
o Определите, какие поисковые системы вы будете использовать (рекомендуется 

использовать как минимум две разные системы для сравнения результатов). 

Этап 2: Практическая работа  

Вам будут предложены несколько задач на поиск информации. Для каждой задачи 

необходимо: 

1. Четко сформулировать задачу: Определите, какую именно информацию вам 

необходимо найти. 



2. Составить поисковый запрос: Сформулируйте поисковый запрос, используя 

подходящие ключевые слова, операторы и фильтры. Обоснуйте свой выбор ключевых 

слов. 

3. Выполнить поиск: Выполните поиск в выбранных поисковых системах. 

4. Оценить результаты: Просмотрите результаты поиска и выберите наиболее 

релевантные и надежные источники информации. 

5. Извлечь необходимую информацию: Найдите нужную информацию в отобранных 

источниках. 

6. Записать результат: Запишите найденную информацию, указав источник (URL, 

автор, название статьи/книги, дата публикации). Кратко опишите, почему вы выбрали 

именно этот источник (критерии оценки). 

Задачи для поиска: 

1. Поиск определения термина: 
o Найдите определение термина "[Выберите термин из вашей предметной области, 

например, 'машинное обучение', 'блокчейн', 'квантовый компьютер']" в 

авторитетных источниках (например, в научных статьях, энциклопедиях, 

учебниках). 

2. Поиск информации о событии: 
o Найдите информацию о "[Выберите историческое или текущее событие, например, 

'запуск первого спутника', 'климатическая конференция ООН', 'последние 

достижения в области вакцинации']". Укажите дату и место проведения события 

(если применимо). 

3. Поиск ответа на вопрос: 
o Ответьте на вопрос: "[Сформулируйте вопрос, требующий аналитического ответа, 

например, 'Какие основные преимущества и недостатки использования облачных 

технологий?', 'Каковы основные причины роста популярности электромобилей?', 

'Какие основные этические проблемы возникают при использовании 

искусственного интеллекта?']". Приведите несколько точек зрения, подкрепленных 

ссылками на источники. 

4. Поиск изображений: 
o Найдите изображения, иллюстрирующие "[Выберите тему для поиска 

изображений, например, 'архитектура модерна', 'редкие виды животных', 

'космические телескопы']". Укажите авторство изображений и лицензию (если 

применимо, например, Creative Commons). 

5. Поиск научной статьи: 
o Найдите научную статью на тему "[Сформулируйте тему для поиска научной 

статьи, например, 'применение нейронных сетей в медицине', 'влияние социальных 

сетей на психическое здоровье молодежи', 'разработка новых материалов для 

солнечных батарей']". Укажите название статьи, авторов, название журнала и год 

публикации. 

Этап 3: Оформление отчета  

1. Оформите отчет о проделанной работе. Отчет должен включать: 

o Титульный лист (название работы, ФИО, группа, дата). 

o Для каждой задачи: 

 Формулировку задачи. 

 Поисковый запрос (или несколько запросов, если потребовалось уточнение). 

 Перечень поисковых систем, которые вы использовали. 



 Список найденных источников информации (с указанием URL, авторов, 

названий и дат). 

 Краткое описание каждого источника и обоснование его выбора. 

 Ответ на вопрос (если это была задача на поиск ответа на вопрос). 

o Заключение, в котором вы делаете выводы о: 

 Эффективности различных поисковых систем для решения разных типов задач. 

 Важности правильного формулирования поисковых запросов. 

 Необходимости критической оценки найденной информации. 

 Какие новые навыки вы приобрели в ходе выполнения работы. 

Критерии оценки: 

 Правильность и полнота выполнения задач (50%): 
o Полнота и точность найденной информации. 

o Соответствие найденной информации поставленным задачам. 

 Эффективность использования поисковых инструментов (20%): 
o Умение формулировать поисковые запросы с использованием ключевых слов, 

операторов и фильтров. 

o Использование различных поисковых систем и специализированных ресурсов. 

 Оценка достоверности и актуальности информации (20%): 
o Умение определять надежность и объективность источников информации. 

o Оценка актуальности найденной информации. 

 Оформление отчета (10%): 
o Полнота и ясность описания проделанной работы. 

o Логичность и структурированность отчета. 

Рекомендации: 

 Начните с общих запросов и постепенно уточняйте их, добавляя ключевые слова и 

операторы. 

 Используйте разные поисковые системы для сравнения результатов. 

 Обращайте внимание на дату публикации информации, особенно если ищете 

актуальные данные. 

 Критически оценивайте источники информации, учитывайте их авторитетность и 

объективность. 

 Сохраняйте найденные источники информации для дальнейшего использования. 

 

Практическая работа № 29-30. Примеры работы с Интернет-магазином, интернет-

библиотекой 

Цель работы: Закрепить практические навыки работы с онлайн-магазинами и 

электронными библиотеками, изучить их функциональность и возможности для решения 

пользовательских задач. 

Задачи: 

1. Анализ интерфейса и функциональности: Изучить интерфейс и функциональность 

выбранного интернет-магазина и интернет-библиотеки. 

2. Поиск товаров/книг: Освоить эффективные методы поиска товаров (в магазине) или 

книг (в библиотеке) с использованием фильтров, категорий, ключевых слов и других 

инструментов. 



3. Оценка товаров/книг: Научиться оценивать товары или книги на основе описаний, 

отзывов, рейтингов и других характеристик. 

4. Оформление и оплата заказа (для интернет-магазина): (Виртуальное) Создать и 

оформить заказ в интернет-магазине, ознакомиться с доступными способами оплаты и 

доставки. (Внимание! Реальную оплату производить не нужно! Смоделируйте 

процесс). 

5. Работа с личным кабинетом: Освоить функциональность личного кабинета, включая 

просмотр истории заказов/чтения, управление профилем и настройками. 

6. Использование сервисов поддержки: (Опционально) Изучить возможности 

обращения в службу поддержки (чат, email, телефон) и задать вопрос, связанный с 

использованием сервиса. 

7. Оценка удобства использования: Оценить удобство использования выбранных 

онлайн-платформ с точки зрения навигации, поиска, оформления заказов/чтения и 

других параметров. 

8. Сравнение функциональности: Сравнить функциональность и возможности разных 

интернет-магазинов или интернет-библиотек (по выбору). 

Этапы выполнения работы: 

Этап 1: Выбор платформ  

1. Интернет-магазин: Выберите один из популярных интернет-магазинов (например, 

Ozon, Wildberries, Lamoda). 

2. Интернет-библиотека: Выберите одну из популярных интернет-библиотек 

(например, Литрес, MyBook, Bookmate или университетскую электронную 

библиотечную систему). Уточните у преподавателя, какие библиотеки 

предпочтительнее. 

Этап 2: Работа с интернет-магазином  

1. Поиск товара: 
o Определите товар, который вы хотите "купить" (например, книгу, наушники, 

одежду). 

o Используйте различные методы поиска (категории, фильтры, ключевые слова) для 

нахождения этого товара. 

o Сделайте скриншот страницы с результатами поиска. 

2. Анализ товара: 
o Выберите один товар из результатов поиска. 

o Внимательно изучите описание товара, характеристики, отзывы покупателей, 

рейтинг. 

o Сделайте скриншоты страницы товара, включая описание, отзывы и 

характеристики. 

3. Оформление заказа (виртуальное): 
o Добавьте товар в корзину. 

o Перейдите в корзину. 

o Заполните необходимые поля для оформления заказа (имя, адрес доставки - можно 

использовать выдуманные данные). 

o Выберите способ доставки и оплаты (не производите реальную оплату!). 

o Сделайте скриншоты страниц корзины и оформления заказа. 

4. Изучение личного кабинета: 
o Найдите и изучите разделы личного кабинета, такие как история заказов, личные 

данные, бонусы и скидки. 



o Сделайте скриншоты интересных или важных разделов личного кабинета. 

Этап 3: Работа с интернет-библиотекой 

1. Поиск книги: 
o Определите книгу, которую вы хотите "прочитать" (учебник, художественную 

литературу, научную статью). 

o Используйте различные методы поиска (категории, жанры, авторы, ключевые 

слова) для нахождения этой книги. 

o Сделайте скриншот страницы с результатами поиска. 

2. Анализ книги: 
o Выберите одну книгу из результатов поиска. 

o Внимательно изучите описание книги, содержание (если доступно), отзывы 

читателей, рейтинг. 

o Сделайте скриншоты страницы книги, включая описание, отзывы и содержание 

(если есть). 

3. Чтение книги (фрагмент): 
o Если библиотека позволяет, откройте книгу для чтения онлайн или скачайте 

фрагмент (если это бесплатно). 

o Сделайте скриншот процесса чтения (если возможно). 

4. Изучение личного кабинета: 
o Найдите и изучите разделы личного кабинета, такие как история чтения, закладки, 

избранное, рекомендации. 

o Сделайте скриншоты интересных или важных разделов личного кабинета. 

Этап 4: Оформление отчета 

1. Оформите отчет о проделанной работе. Отчет должен включать: 

o Титульный лист (название работы, ФИО, группа, дата). 

o Раздел "Интернет-магазин": 

 Название выбранного интернет-магазина. 

 Описание процесса поиска товара (с указанием использованных методов и 

скриншотами). 

 Анализ выбранного товара (с указанием основных характеристик, отзывов и 

скриншотами). 

 Описание процесса оформления заказа (виртуального) (со скриншотами). 

 Описание функциональности личного кабинета (со скриншотами). 

 Ваша оценка удобства использования интернет-магазина (основные плюсы и 

минусы). 

o Раздел "Интернет-библиотека": 

 Название выбранной интернет-библиотеки. 

 Описание процесса поиска книги (с указанием использованных методов и 

скриншотами). 

 Анализ выбранной книги (с указанием основных характеристик, отзывов и 

скриншотами). 

 Описание процесса чтения (если возможно). 

 Описание функциональности личного кабинета (со скриншотами). 

 Ваша оценка удобства использования интернет-библиотеки (основные плюсы и 

минусы). 

o Сравнение (если выбрано задание на сравнение): 

 Если вам было предложено сравнить разные магазины/библиотеки, проведите 

сравнительный анализ по нескольким критериям (например, удобство поиска, 



ассортимент, цены/подписка, функциональность личного кабинета) и 

представьте результаты в виде таблицы. 

o Заключение: 

 Сделайте выводы о возможностях и преимуществах использования интернет-

магазинов и интернет-библиотек. 

 Оцените, насколько полезными оказались эти платформы для решения ваших 

задач (например, покупки товаров, чтения книг). 

 Укажите, какие новые навыки вы приобрели в ходе выполнения работы. 

Критерии оценки: 

 Полнота выполнения заданий (50%): 
o Выполнение всех этапов работы с интернет-магазином и интернет-библиотекой. 

o Наличие всех необходимых скриншотов. 

 Качество анализа (30%): 
o Детальный анализ интерфейса, функциональности и контента платформ. 

o Обоснованная оценка удобства использования. 

o Четкое описание процесса поиска, выбора и "оформления заказа/чтения". 

 Оформление отчета (20%): 
o Полнота и ясность описания проделанной работы. 

o Логичность и структурированность отчета. 

o Правильное оформление скриншотов и подписей к ним. 

Рекомендации: 

 Внимательно изучите интерфейс и функциональность выбранных платформ. 

 Не торопитесь при оформлении заказа (даже виртуального), внимательно заполняйте 

все поля. 

 Обращайте внимание на отзывы и рейтинги товаров/книг. 

 Изучите условия доставки/подписки и способы оплаты. 

 Делайте скриншоты на каждом этапе работы, чтобы проиллюстрировать свои действия 

в отчете. 

 

 

Практическая работа № 31-32. Электронная почта. Адресная книга. Социальные сети 

Цель работы: Закрепить практические навыки работы с электронной почтой, адресной 

книгой и социальными сетями, научиться эффективно использовать эти инструменты для 

коммуникации, организации информации и построения личного бренда. 

Задачи: 

1. Настройка учетной записи электронной почты: Научиться настраивать учетную 

запись электронной почты (если еще не настроена) и ознакомиться с основными 

функциями почтового клиента. 

2. Работа с адресной книгой: Научиться добавлять, редактировать и организовывать 

контакты в адресной книге электронной почты или в специализированном 

приложении для управления контактами. 

3. Составление и отправка электронных писем: Освоить навыки составления и 

отправки электронных писем, включая форматирование текста, добавление вложений, 

использование подписи и настройку уведомлений. 



4. Организация входящей корреспонденции: Научиться фильтровать, сортировать и 

архивировать входящие письма, использовать метки и папки для организации 

корреспонденции. 

5. Использование социальных сетей для профессиональных целей: Изучить 

возможности социальных сетей для построения личного бренда, поиска работы, 

установления профессиональных контактов и обмена информацией. 

6. Обеспечение безопасности и конфиденциальности в социальных сетях: Научиться 

настраивать параметры конфиденциальности в социальных сетях, защищать свою 

учетную запись от взлома и избегать распространения личной информации. 

7. Соблюдение этикета в электронной переписке и социальных сетях: Усвоить 

правила этикета в электронной переписке и социальных сетях, чтобы обеспечить 

эффективную и вежливую коммуникацию. 

Этапы выполнения работы: 

Этап 1: Настройка и изучение электронной почты  

1. Настройка учетной записи (если необходимо): 
o Если у вас еще нет учетной записи электронной почты, зарегистрируйте ее на 

одном из популярных сервисов (Gmail, Yandex.Mail, Mail.ru). 

o Настройте почтовый клиент (например, Outlook, Thunderbird) или используйте веб-

интерфейс почтового сервиса. 

2. Изучение интерфейса: 
o Ознакомьтесь с основными элементами интерфейса почтового клиента: входящие, 

отправленные, черновики, спам, корзина, адресная книга, настройки. 

o Сделайте скриншот вашего почтового клиента с выделенными основными 

элементами интерфейса. 

3. Настройка подписи: 
o Создайте подпись, которая будет автоматически добавляться ко всем вашим 

письмам. Подпись должна содержать ваше имя, фамилию, должность (если 

применимо) и контактную информацию. 

o Сделайте скриншот настроек вашей подписи. 

Этап 2: Работа с адресной книгой  

1. Добавление контактов: 
o Добавьте в адресную книгу как минимум 5 контактов: преподавателей, 

одногруппников, друзей, родственников. 

o Для каждого контакта укажите имя, фамилию, адрес электронной почты и 

дополнительную информацию (например, номер телефона, место работы/учебы). 

o Сделайте скриншот вашей адресной книги с добавленными контактами. 

2. Организация контактов: 
o Создайте группы контактов (например, "Преподаватели", "Одногруппники", 

"Друзья"). 

o Добавьте контакты в соответствующие группы. 

o Сделайте скриншот вашей адресной книги с группами контактов. 

Этап 3: Составление и отправка электронных писем  

1. Отправка письма преподавателю: 
o Составьте и отправьте письмо преподавателю с вопросом по учебному курсу. 



o Соблюдайте правила этикета в электронной переписке (вежливое обращение, 

четкая формулировка вопроса, благодарность). 

o Включите свою подпись в письмо. 

o Сделайте скриншот отправленного письма. 

2. Отправка письма группе контактов: 
o Составьте и отправьте письмо группе контактов (например, одногруппникам) с 

информацией о предстоящем мероприятии. 

o Используйте функцию "скрытая копия" (BCC), чтобы скрыть адреса получателей 

друг от друга. 

o Прикрепите к письму файл (например, программу мероприятия). 

o Сделайте скриншот отправленного письма. 

3. Фильтрация и сортировка писем: *Настройте фильтр для автоматической 

сортировки писем от определенного отправителя (например, от вашей 

образовательной платформы) в отдельную папку или с присвоением метки. 

Этап 4: Использование социальных сетей для профессиональных целей 

1. Выберите социальную сеть: Выберите одну социальную сеть (например, LinkedIn, 

Facebook) и проанализируйте ее с точки зрения возможностей для профессионального 

развития. 

2. Оптимизируйте свой профиль: 
o Убедитесь, что ваш профиль содержит актуальную информацию о вашей учебе, 

навыках и интересах. 

o Добавьте профессиональную фотографию. 

o Напишите краткое описание о себе, подчеркивающее ваши сильные стороны и 

карьерные цели. 

o Сделайте скриншот вашего профиля. 

3. Найдите профессиональные группы: 
o Найдите как минимум 3 группы, связанные с вашей специальностью или 

профессиональными интересами. 

o Вступите в эти группы. 

o Сделайте скриншот списка групп, в которые вы вступили. 

4. Установите контакты: 
o Найдите и добавьте в контакты как минимум 5 преподавателей, выпускников или 

специалистов, работающих в интересующей вас области. 

o Напишите каждому из них персональное приветственное сообщение. 

o Сделайте скриншот списка ваших контактов. 

5. Оцените настройки приватности: *Проверьте ваши настройки приватности и 

убедитесь, что они соответствуют вашим предпочтениям по видимости вашего 

профиля и контента. 

Этап 5: Оформление отчета  

1. Оформите отчет о проделанной работе. Отчет должен включать: 

o Титульный лист (название работы, ФИО, группа, дата). 

o Раздел "Электронная почта": 

 Описание настройки учетной записи электронной почты (если выполнялась). 

 Скриншот интерфейса почтового клиента с выделенными основными 

элементами. 

 Скриншот настроек подписи. 

 Скриншот адресной книги с добавленными контактами и группами. 

 Скриншот отправленного письма преподавателю. 



 Скриншот отправленного письма группе контактов. 

o Раздел "Социальные сети": 

 Название выбранной социальной сети. 

 Скриншот вашего профиля. 

 Скриншот списка профессиональных групп, в которые вы вступили. 

 Скриншот списка ваших контактов. 

o Заключение: 

 Сделайте выводы о возможностях и преимуществах использования 

электронной почты и социальных сетей для коммуникации, организации 

информации и построения личного бренда. 

 Оцените, насколько полезными оказались эти инструменты для вашей учебы и 

будущей карьеры. 

 Укажите, какие новые навыки вы приобрели в ходе выполнения работы. 

Критерии оценки: 

 Полнота выполнения заданий (50%): 
o Выполнение всех этапов работы с электронной почтой и социальными сетями. 

o Наличие всех необходимых скриншотов. 

 Качество выполнения заданий (30%): 
o Правильность настройки учетной записи электронной почты. 

o Эффективность использования адресной книги. 

o Соблюдение правил этикета в электронной переписке и социальных сетях. 

o Оптимизация профиля в социальной сети для профессиональных целей. 

 Оформление отчета (20%): 
o Полнота и ясность описания проделанной работы. 

o Логичность и структурированность отчета. 

o Правильное оформление скриншотов и подписей к ним. 

Рекомендации: 

 Внимательно изучите интерфейс и функциональность почтового клиента и социальной 

сети. 

 Соблюдайте правила этикета при общении в электронной почте и социальных сетях. 

 Настройте параметры конфиденциальности в социальных сетях для защиты своей 

личной информации. 

 Используйте социальные сети для поиска работы, установления профессиональных 

контактов и обмена информацией. 

 Регулярно обновляйте свой профиль в социальных сетях и поддерживайте контакты с 

коллегами и друзьями. 

Практическая работа № 33-34 

Цель практической работы: 

 Научиться создавать простой сайт-визитку с использованием онлайн-редактора. 

 Освоить основные инструменты и функции онлайн-редактора. 

 Развить навыки веб-дизайна и компоновки информации. 

 Спроектировать и реализовать структуру сайта-визитки, ориентированную на целевую 

аудиторию. 

Выбор онлайн-редактора: 



Существует множество онлайн-редакторов сайтов, но для простоты и доступности 

предлагаю использовать один из самых популярных и удобных: 

 Tilda Publishing: (tilda.cc) - Очень интуитивный интерфейс, большой выбор шаблонов, 

возможность бесплатного использования с ограничениями. 

 Wix: (wix.com) - Огромное количество функций и возможностей, drag-and-drop 

интерфейс, но бесплатная версия с рекламой. 

 Google Sites: (sites.google.com) - Простой и бесплатный редактор от Google, 

интеграция с другими сервисами Google (Docs, Drive, Calendar), но ограниченная 

функциональность. 

Рекомендуется Tilda Publishing для новичков. Выберите тот, который вам больше 

нравится и с которым вам удобнее работать. 

Этапы выполнения практической работы: 

1. Планирование (20 минут): 
o Определите цель сайта-визитки: Для кого он предназначен? Какую информацию 

вы хотите донести? (Например, продвижение услуг фрилансера, представление 

компании, личное портфолио). 

o Определите целевую аудиторию: Кто будет посещать ваш сайт? Каковы их 

интересы и потребности? 

o Разработайте структуру сайта: Какие страницы будут на вашем сайте? Обычно 

сайт-визитка состоит из 3-5 страниц: 

 Главная страница: Краткое представление себя/компании, слоган, 

привлекательное изображение. 

 Обо мне/О компании: Подробная информация о себе/компании, опыт, 

достижения. 

 Услуги/Портфолио: Описание услуг/примеры работ. 

 Контакты: Форма обратной связи, телефон, email, ссылки на социальные сети. 

 (Опционально) Блог/Новости: Статьи, новости, полезная информация для 

целевой аудитории. 

o Соберите контент: Подготовьте текст, изображения, видео, которые будете 

использовать на сайте. Важно, чтобы контент был качественным и соответствовал 

вашей целевой аудитории. Заранее подготовьте фотографии, логотип, текст для 

каждой страницы. 

o Набросайте макет (скетч) сайта на бумаге: Это поможет вам визуализировать 

структуру и расположение элементов на каждой странице. Необязательно, но 

полезно для понимания общей картины. 

2. Регистрация и выбор шаблона (10 минут): 
o Зарегистрируйтесь на выбранном онлайн-редакторе (Tilda, Wix, Google Sites). 

o Выберите готовый шаблон сайта-визитки, который соответствует вашей цели и 

структуре. Обратите внимание на дизайн, расположение блоков, цветовую гамму. 

Помните, что шаблон можно будет изменить под себя. 

3. Создание и редактирование страниц (60 минут): 

o Главная страница: 
 Замените текст на свой. Напишите короткое, но привлекательное описание 

себя/компании. 

 Добавьте изображение (фотографию, логотип, иллюстрацию). 

 Добавьте кнопки с призывом к действию (например, "Узнать больше", 

"Связаться со мной"). 

o Обо мне/О компании: 



 Напишите подробную информацию о себе/компании. Расскажите о своем 

опыте, достижениях, ценностях. 

 Добавьте фотографии, видео, отзывы клиентов. 

o Услуги/Портфолио: 
 Опишите свои услуги/представьте примеры работ. 

 Разделите услуги на категории для удобства навигации. 

 Добавьте изображения, описания, цены. 

o Контакты: 
 Добавьте форму обратной связи, чтобы посетители могли связаться с вами. 

 Укажите телефон, email, ссылки на социальные сети. 

 Разместите карту с вашим местоположением (если необходимо). 

o Используйте drag-and-drop интерфейс: Перетаскивайте блоки, изменяйте их 

размер и расположение. 

o Настраивайте дизайн: Изменяйте шрифты, цвета, фоны, отступы. 

o Добавляйте анимацию: Используйте анимацию, чтобы сделать сайт более 

интерактивным и привлекательным. Не переусердствуйте! 

o Оптимизируйте изображения: Уменьшите размер изображений, чтобы страница 

загружалась быстрее. 

o Добавьте мета-теги: Оптимизируйте сайт для поисковых систем (SEO). 

4. Настройка навигации и структуры сайта (20 минут): 
o Создайте меню навигации, чтобы посетители могли легко перемещаться между 

страницами. 

o Добавьте внутренние ссылки на странице, чтобы улучшить структуру сайта. 

o Убедитесь, что все ссылки работают правильно. 

5. Тестирование и оптимизация (20 минут): 
o Проверьте, как сайт отображается на разных устройствах (компьютере, планшете, 

смартфоне). 

o Проверьте скорость загрузки страниц. 

o Проверьте орфографию и грамматику. 

o Попросите друзей или коллег оценить ваш сайт и дать обратную связь. 

o Внесите необходимые изменения на основе обратной связи. 

6. Публикация сайта (10 минут): 
o Опубликуйте свой сайт на выбранном онлайн-редакторе. 

o Выберите доменное имя (если доступно). В бесплатных версиях обычно 

предлагается поддомен редактора. 

7. Составление отчета (30 минут): 
o Опишите цель и задачи работы. 

o Опишите процесс создания сайта (какой редактор использовали, какой шаблон 

выбрали, какие страницы создали). 

o Опишите трудности, с которыми вы столкнулись, и как вы их преодолели. 

o Предоставьте скриншоты каждой страницы сайта. 

o Укажите ссылку на опубликованный сайт. 

o Сделайте выводы о том, что вы узнали и чему научились в ходе выполнения 

работы. 

o Оцените свой результат: что получилось хорошо, а что можно было бы улучшить. 

Дополнительные советы: 

 Уделите внимание дизайну: Используйте качественные изображения, подберите 

гармоничные цвета, выберите читабельный шрифт. 

 Будьте краткими и информативными: Не перегружайте сайт лишней информацией. 



 Оптимизируйте сайт для мобильных устройств: Большинство пользователей 

просматривают сайты с мобильных устройств. 

 Используйте SEO-оптимизацию: Оптимизируйте сайт для поисковых систем, чтобы 

его было легче найти в Интернете. 

 Анализируйте статистику посещений: Используйте инструменты аналитики, чтобы 

отслеживать посещаемость сайта и поведение пользователей. 

Пример структуры сайта-визитки для фрилансера-дизайнера: 

 Главная: Фотография, имя, слоган ("Создаю стильные и функциональные сайты"), 

кнопки "Портфолио", "Контакты". 

 Обо мне: Информация об опыте, образовании, навыках, подходе к работе. 

 Портфолио: Примеры работ с описанием и ссылками на сайты. 

 Услуги: Список услуг (веб-дизайн, логотипы, фирменный стиль) с ценами. 

 Контакты: Форма обратной связи, телефон, email, ссылки на социальные сети. 

Предполагаемые трудности: 

 Выбор подходящего шаблона. 

 Настройка дизайна и компоновки элементов. 

 Оптимизация изображений. 

 Оптимизация сайта для мобильных устройств. 

 SEO-оптимизация. 

Критерии оценки: 

 Соответствие сайта цели и задачам. 

 Качество дизайна и компоновки. 

 Функциональность и удобство использования. 

 Оптимизация для мобильных устройств. 

 SEO-оптимизация (базовая). 

 Полнота и информативность отчета. 

 

 

Практическая работа № 35-36. Использование сервисов Google Docs для совместной 

работы с документами 

Цель практической работы: 

 Освоить основные функции Google Docs. 

 Научиться совместно работать над документами в Google Docs. 

 Изучить различные режимы доступа и права пользователей. 

 Использовать возможности комментирования и отслеживания изменений. 

 Узнать о дополнительных функциях Google Docs, полезных для командной работы. 

Этапы выполнения практической работы: 

1. Подготовка (15 минут): 
o Убедитесь, что у вас есть аккаунт Google. Если нет, создайте его (это бесплатно). 

o Определите тему документа для совместной работы. Это может быть любой 

текст, над которым могут работать несколько человек (например, проект отчета, 



сценарий, статья, план мероприятия). Выберите что-то, что интересно вам и вашим 

коллегам. 

o Найдите 2-3 человек, которые будут участвовать в совместной работе. 
Убедитесь, что у них тоже есть аккаунты Google. 

o Распределите роли (необязательно, но полезно): Определите, кто будет 

руководителем проекта, кто будет отвечать за определенные разделы документа и 

т.д. 

2. Создание и настройка документа (20 минут): 
o Создайте новый документ в Google Docs: Перейдите на сайт Google Drive 

(drive.google.com), нажмите кнопку "Создать" и выберите "Google Документы". 

o Дайте документу осмысленное название: Это облегчит его поиск в будущем. 

o Настройте доступ к документу: Нажмите кнопку "Настройки доступа" (зеленая 

кнопка сверху справа). Очень важный шаг! От этого зависит, кто сможет 

видеть и редактировать документ. 

 Общий доступ по ссылке: 
 "Просматривать": Только для чтения (пользователи могут просматривать 

и комментировать, но не могут вносить изменения). 

 "Комментировать": Просмотр и возможность добавления комментариев 

(полезно для рецензирования). 

 "Редактировать": Полный доступ для редактирования (пользователи 

могут вносить любые изменения в документ). 

 Доступ отдельным пользователям: Введите email-адреса ваших коллег и 

выберите уровень доступа (просмотр, комментирование, редактирование). 

o Отправьте ссылку на документ своим коллегам. Объясните им, какой уровень 

доступа вы им предоставили. 

3. Совместная работа над документом (60 минут): 
o Начните заполнять документ: Внесите свой вклад в соответствии с темой и 

ролями (если они были распределены). 

o Используйте функции форматирования Google Docs: Оформляйте текст, 

добавляйте заголовки, списки, таблицы, изображения и т.д. 

o Активно используйте комментирование: 
 Выделяйте фрагменты текста и добавляйте комментарии, чтобы задавать 

вопросы, предлагать улучшения, выражать свое мнение. 

 Отвечайте на комментарии своих коллег, ведите обсуждения. 

 Помечайте комментарии как "Разрешено", когда проблема решена. 

o Используйте функцию "Предложить исправления": В этом режиме ваши 

изменения будут отображаться как предложения, которые другие участники могут 

принять или отклонить. (Включается в меню "Режим редактирования" –> 

"Предложить исправления"). Это очень полезно для рецензирования и согласования 

текста. 

o Обсуждайте вопросы в чате (если необходимо): В Google Docs есть встроенный 

чат, который можно использовать для быстрого обсуждения возникающих 

вопросов. (Значок чата сверху справа). 

o Экспериментируйте с версиями документа: Google Docs автоматически 

сохраняет историю изменений. Вы можете просмотреть предыдущие версии 

документа и вернуться к ним, если это необходимо (Файл -> История версий -> 

Посмотреть историю версий). 

4. Изучение дополнительных функций (20 минут): 
o Поиск и замена: Используйте функцию поиска и замены (Ctrl+H), чтобы быстро 

найти и заменить определенные слова или фразы в документе. 

o Проверка орфографии и грамматики: Используйте встроенный инструмент 

проверки орфографии и грамматики (Инструменты -> Орфография и грамматика). 

https://geekbot.ru/drive.google.com


o Голосовой ввод: Используйте функцию голосового ввода (Инструменты -> 

Голосовой ввод), чтобы диктовать текст. Это может быть полезно, если вам 

неудобно печатать. 

o Перевод документа: Используйте функцию перевода документа (Инструменты -> 

Перевести документ), чтобы перевести документ на другой язык. 

o Дополнительные инструменты (Дополнения): Установите дополнения 

(Дополнения -> Установить дополнения), чтобы расширить функциональность 

Google Docs (например, для создания диаграмм, вставки математических формул, 

управления библиографией). 

5. Завершение и оформление (15 минут): 

o Убедитесь, что все участники внесли свой вклад. 

o Проверьте документ на наличие ошибок и неточностей. 

o Оформите документ в соответствии с требованиями (если они есть). 

o Убедитесь, что у всех участников есть доступ к финальной версии документа. 

6. Составление отчета (30 минут): 

o Опишите цель и задачи работы. 

o Опишите процесс совместной работы над документом: 
 Какая тема была выбрана? 

 Кто участвовал в работе? 

 Какие роли были распределены (если были)? 

 Какие функции Google Docs использовались для совместной работы 

(комментирование, предложения, чат, история версий)? 

 Какие трудности возникли в процессе работы и как они были преодолены? 

o Предоставьте скриншоты: 
 Скриншот настроек доступа к документу. 

 Скриншот примера использования комментирования. 

 Скриншот примера использования функции "Предложить исправления". 

 Скриншот истории версий документа. 

 Скриншот примера использования дополнительных функций (если вы их 

использовали). 

o Укажите ссылку на финальную версию документа. 

o Сделайте выводы: 
 Что вы узнали о Google Docs и совместной работе? 

 Какие преимущества и недостатки совместной работы в Google Docs вы 

выявили? 

 Как вы планируете использовать Google Docs для совместной работы в 

будущем? 

 Какие советы вы можете дать другим пользователям, начинающим работать с 

Google Docs? 

o Оцените свой вклад в совместную работу и вклад других участников. 

Пример темы документа: 

 "План проведения конференции 'Инновации в образовании'" 

 "Статья для студенческого научного журнала 'Современные тренды в IT'" 

 "Сценарий короткометражного фильма 'Мечты сбываются'" 

 "Отчет о прохождении производственной практики" 

Критерии оценки: 

 Активное участие в совместной работе. 

 Использование различных функций Google Docs для совместной работы. 



 Качество и информативность отчета. 

 Наличие скриншотов, подтверждающих использование функций Google Docs. 

 Сформулированные выводы о преимуществах и недостатках совместной работы в 

Google Docs. 

Дополнительные советы: 

 Будьте вежливы и уважительны к своим коллегам. 

 Внимательно читайте комментарии и предложения других участников. 

 Вносите свой вклад в работу своевременно. 

 Не стесняйтесь задавать вопросы, если что-то непонятно. 

 Изучите различные дополнения для Google Docs, чтобы расширить его 

функциональность. 

 


